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This manual is part of a set of Color Controller E-820

 

™

 

 documentation that includes 
the following manuals for users and system administrators:

• The

 

 Quick Start Guide

 

 summarizes the steps for configuring the E-820 and printing. 
It also describes how to access the online documentation. 

• The

 

 User Software Installation Guide 

 

describes how to install software from the 
User Software CD to enable users to print to the E-820, and also describes setting 
up printing connections to the E-820.

• The

 

 Configuration Guide 

 

explains basic configuration and administration of the 
E-820 for the supported platforms and network environments. It also includes 
guidelines for setting up UNIX, Windows NT 4.0/2000, and Novell NetWare 
servers to provide printing services to users. 

• The

 

 Printing Guide

 

 describes the printing features of the E-820 for users who send 
jobs from their computers.

• The

 

 Color Guide 

 

provides information on managing the color output of the E-820. 
It explains how to calibrate your copier and take advantage of the EFI Fiery 
ColorWise

 

®

 

 color management system, as well as features in ColorWise Pro Tools

 

™

 

. 

• The

 

 Fiery Color Reference 

 

addresses concepts and issues associated with managing 
color output of the E-820 and outlines key workflow scenarios. In addition, it offers 
information on printing color documents from popular Microsoft Windows and 
Apple Mac OS applications.

• The

 

 Job Management Guide 

 

explains the functions of the job management utilities, 
including EFI Command WorkStation

 

™ 

 

and EFI Fiery DocBuilder

 

 

 

Pro

 

™

 

, and how 
you can use them to monitor and control jobs on the E-820. This manual is 
intended for an operator or administrator, or a user with the necessary access 
privileges, who monitors and manages job flow, performs color calibration, and 
troubleshoots problems that may arise.

•

 

Release Notes

 

 provide last-minute product information and workarounds for some of 
the problems you may encounter.
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FCC Information

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly approved by the manufacturer could void 
the user’s authority to operate this equipment. 

Class A Compliance

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed 
to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, and uses, 
and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio 
communications. Operation of this equipment in a residential area is likely to cause interference in which case the user will be required to correct the interference 
at his own expense. 

Industry Canada Class A Notice

This Class A digital apparatus complies with Canadian ICES-003.

Avis de Conformation Classe A de l’Industrie Canada 

Cet appareil numérique de la Classe A est conforme à la norme NMB-003 du Canada.

RFI Compliance Notice

This equipment has been tested concerning compliance with the relevant RFI protection requirements both individually and on system level (to simulate normal 
operation conditions). However, it is possible that these RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user 
who is responsible for compliance of his particular installation.

Dieses Gerät wurde sowohl einzeln als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf die Einhaltung der Funkentstörbestimmungen 
geprüft. Es ist jedoch möglich, dass die Funkentstörbestimmungen unter ungünstigen Umständen bei anderen Gerätekombinationen nicht eingehalten werden. 
Für die Einhaltung der Funkentstörbestimmungen einer gesamten Anlage, in der dieses Gerät betrieben wird, ist der Betreiber verantwortlich.

Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for procuring the appropriate cables.

Die Einhaltung zutreffender Bestimmungen hängt davon ab, dass geschirmte Ausführungen benützt werden. Für die Beschaffung richtiger Ausführungen ist der 
Betreiber verantwortlich.

Software License Agreement

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS SOFTWARE. IF YOU DO NOT 
AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT USE THE SOFTWARE. INSTALLING OR USING THE 
SOFTWARE INDICATES THAT YOU AGREE TO AND ACCEPT THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO ACCEPT 
THE TERMS OF THIS AGREEMENT YOU MAY RETURN THE UNUSED SOFTWARE FOR A FULL REFUND TO THE PLACE OF PURCHASE. 

License

EFI grants you a non-exclusive license to use the software (“Software”) and accompanying documentation (“Documentation”) included with the Product. The 
Software is licensed, not sold. You may use the Software solely for your own customary business or personal purposes. You may not rent, lease, sublicense or lend 
the Software. You may, however, permanently transfer all of your rights under this Agreement to another person or legal entity provided that: (1) you transfer to 
the person or entity all of the Software and Documentation (including all copies, updates, upgrades, prior versions, component parts, the media and printed 
materials, and this Agreement); (2) you retain no copies of the Software and Documentation, including copies stored on a computer; and (3) the recipient agrees 
to the terms and conditions of this Agreement. 

You may not make or have made, or permit to be made, any copies of the Software or portions thereof, except as necessary for backup or archive purposes in 
support of your use of the Software as permitted hereunder. You may not copy the Documentation. You may not attempt to alter, disassemble, decompiler, decrypt 
or reverse engineer the Software.

Proprietary Rights

You acknowledge that the Software is proprietary to EFI and its suppliers and that title and other intellectual property rights therein remain with EFI and its 
suppliers. Except as stated above, this Agreement does not grant you any right to patents, copyrights, trade secrets, trademarks (whether registered or unregistered), 
or any other rights, franchises or licenses in respect of the Software. You may not adopt or use any trademark or trade name which is likely to be similar to or 
confusing with that of EFI or any of its suppliers or take any other action which impairs or reduces the trademark rights of EFI or its suppliers.



              
Confidentiality

You agree to hold the Software in confidence, disclosing the Software only to authorized users having a need to use the Software as permitted by this Agreement 
and to take all reasonable precautions to prevent disclosure to other parties.

Remedies and Termination

Unauthorized use, copying or disclosure of the Software, or any breach of this Agreement will result in automatic termination of this license and will make available 
to EFI other legal remedies. In the event of termination, you must destroy all copies of the Software and all of its component parts. All provisions of this Agreement 
relating to disclaimers of warranties, limitation of liability, remedies, damages, and EFI’s proprietary rights shall survive termination.

Limited Warranty and Disclaimer

EFI warrants to the original purchaser (“Customer”) for thirty (30) days from the date of original purchase from EFI or its authorized retailer that the Software 
will perform in substantial conformance to the Documentation when the Product is used as authorized by EFI’s specifications. EFI warrants the media containing 
the Software against failure during the above warranty period. EFI makes no warranty or representation that the Software will meet your specific requirements, 
that the operation of the Software will be uninterrupted or error free, or that all defects in the Software will be corrected. EFI makes no warranty, implied or 
otherwise, regarding the performance or reliability of any third party products (software or hardware) not provided by EFI. THE INSTALLATION OF ANY 
THIRD PARTY PRODUCTS OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY. IN ADDITION, USE, MODIFICATION, 
AND/OR REPAIR OF THE PRODUCT OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, EFI MAKES AND YOU RECEIVE NO WARRANTIES OR CONDITIONS ON THE 
SOFTWARE, EXPRESS, IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION OF THIS AGREEMENT OR COMMUNICATION WITH YOU, 
AND EFI SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR 
PURPOSE OR NONINFRINGEMENT OF THIRD PARTY RIGHTS. 

Limitation of Liability

TO THE MAXIMUM EXTENT PERMITTED BY LAW, EFI AND ITS SUPPLIERS SHALL NOT BE LIABLE FOR ANY DAMAGES, INCLUDING 
LOSS OF DATA, LOST PROFITS, COST OF COVER OR OTHER SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAMAGES 
ARISING FROM THE SALE, INSTALLATION, MAINTENANCE, USE, PERFORMANCE OR FAILURE OF THE SOFTWARE, HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY. THIS LIMITATION WILL APPLY EVEN IF EFI HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. YOU ACKNOWLEDGE THAT THE PRICE OF THE PRODUCT REFLECTS THIS ALLOCATION OF RISK. BECAUSE SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, 
THE ABOVE LIMITATION MAY NOT APPLY TO YOU.

Export Controls

You agree that you will not export or re-export the Software in any form in violation of any applicable laws or regulations of the United States or the country in 
which you obtained them.

U.S. Government Restricted Rights:

The Software and Documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the United States Government is subject to 
restrictions as set forth in subparagraph (c)(1)(ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1) 
and (2) of the Commercial Computer Software Restricted Rights at 48 CFR 52.227-19, as applicable.

General

The laws of the State of California govern this Agreement. You agree that this Agreement shall not be subject to the United Nations Convention on Contracts for 
the International Sale of Goods (1980). This Agreement is the entire agreement held between us and supersedes any other communications or advertising with 
respect to the Software. If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

If you have any questions, please see EFI’s web site at www.efi.com.

Electronics For Imaging
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xi About this manual

                          
The Color Controller E-820™ is used to print final documents or proof jobs that will 
be printed later on an offset press. You can send a print job to the 
Color Controller E-820 as you would to any other printer—select it from the Printers 
dialog box on Microsoft Windows computers, or in the Chooser on Apple Mac OS 
computers, and then print from within any application.

NOTE: The term “E-820” is used in this manual to refer to the Color Controller E-820 
installed in the copier. The name “Aero” is used in illustrations to represent the E-820. 
Windows 9x is used in this manual to refer to Windows 95/98. The term “Windows” 
is used in this manual to refer to Windows 9x/Me, Windows NT 4.0, and 
Windows 2000/XP. 

Although it may not be the case at all sites, it is assumed that an operator controls and 
manages jobs sent by users from remote workstations. For information on the features 
of EFI Command WorkStation, EFI Fiery WebSpooler™, and EFI Fiery Spooler™, see 
the Job Management Guide.

About this manual
This manual is intended for remote users who send jobs via the network and the 
E-820. It covers the following topics:

• Printing from a Windows computer

• Printing from a Mac OS computer

• Printing from a Unix workstation

• Downloading files and fonts using EFI Fiery Downloader™ and EFI 
Fiery WebDownloader™

• Printing variable data documents

• Using EFI Fiery Scan™ 3.4 and EFI Fiery Remote Scan™ software

• Using the EFI Converter (EFI Fiery Graphic Arts Package option)

• Using Hot Folders (EFI Fiery Graphic Arts Package option)

• Monitoring jobs and accessing information using EFI Fiery WebTools™ and 
EFI Fiery Link™

Introduction
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• Printing using the Fiery E-mail Service

• Specifying and overriding job settings, generating a list of fonts installed on the 
E-820, and troubleshooting information
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1-1 Printing from applications

                           
This chapter describes printing to the E-820 from Windows computers. You can 
print from a networked Windows computer or a computer using Windows (WINS) 
printing. You can also save files to print at a remote location. 

You can print from a Windows computer in many ways. You can download PostScript 
(PS), Encapsulated PostScript (EPS), Tagged Image File Format (TIFF), or Portable 
Document Format (PDF) files using Fiery Downloader, or print documents using 
Fiery E-mail Services and Hot Folders. For supported file versions, see the User 
Software Installation Guide.

NOTE: For basic instructions and details on using Fiery Downloader, see Chapter 4. 
For basic instructions on using the Fiery E-mail Service, see Chapter 10, and for details 
on using Hot Folders, see Chapter 8.

NOTE: For information on setting up the Windows environment for printing with 
Windows servers connected to the E-820, see the Configuration Guide. For 
information about connecting to the E-820 over the network, installing printer 
drivers, and installing Fiery® utilities, see the User Software Installation Guide.

Printing from applications
Once the E-820 printer driver is installed and set to the proper port, as described in 
the User Software Installation Guide, you can print directly from most Windows 
applications. Simply set the print options for the job and choose the Print command 
from within your application.

To achieve the best printing results from specific applications, see the Color Guide and 
the Fiery Color Reference.

Setting options and printing from Windows computers
To print from Windows computers, select and install the corresponding Adobe 
PostScript printer driver. The drivers are included on the E-820 User Software CD.

Once the Adobe PostScript printer driver and printer description file (PPD) are 
installed, you can specify print settings for a particular job and print it to the E-820. 
You can also set default print settings using the driver.

Chapter 1:
Printing from 
Windows 
Computers 
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1-2 Printing from Windows Computers

         
To print from Windows applications by connecting your computer to a print server via 
the network, a Novell NetWare, Windows NT, or UNIX server is required. For more 
information, see the Configuration Guide. 

To print from Windows applications without connecting to a print server, 
you can use Server Message Block (SMB) printing. For more information, see the
User Software Installation Guide.

The following procedures explain how to use the driver to specify print options. 
For information about specific print options, see Appendix A.

NOTE: The following procedures use Windows 98 illustrations.

TO SET PRINT OPTIONS FOR A SPECIFIC WINDOWS PRINT JOB USING THE 
ADOBE POSTSCRIPT PRINTER DRIVER

1. Choose Print in your application.

2. Select the E-820 as your printer and click Properties.

3. Click the Fiery Printing tab.

The Fiery Printing tab serves as the control center for all frequently used printing 
functions. 

Print option bars, see below

Shortcuts, see page 1-10

Click to display all print options

Click to hide all print options 

Saved settings, see page 1-6
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NOTE: Supported tabs and print options may vary between Windows 9x/Me, Windows 
NT 4.0, and Windows 2000/XP. For a complete list of print options, see Appendix A.

4. Click the ColorWise print option bar.

In the Print Mode area, specify the color mode for the job. To use advanced color 
management features, such as Rendering Style, click Expert Settings and proceed to 
step 5; otherwise, skip to step 6.

5. In the Expert Color Settings dialog box, click Update to display the current 
E-820 settings.

Click Update
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If the Update button does not appear, make sure Two-Way Communication is set up, 
as described in the User Software Installation Guide.

NOTE: Specify the color settings for the print job and click OK.

6. Click the Owner Information print option bar.

7. Enter the Group Name, Group Password, and text in the Notes area. 

Enter user and job identification information for managing purposes, or whatever 
information is required at your site.

Enter the User ID in the Group Name field. The Group Name also appears in 
Command WorkStation, WebSpooler, and Fiery Spooler Job Log. 

The Administrator or Operator can edit the Group Name and Group Password from 
Command WorkStation, WebSpooler, or Fiery Spooler Properties window. 

The information you enter in the Notes field can be viewed by the operator in 
Command WorkStation and also appears in the Job Log. It cannot be edited or 
deleted by the operator.

NOTE: Group Name and Group Password options are not available when printing to 
the Direct connection.

For more information on Command WorkStation overrides, see the Job Management 
Guide.
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8. In the Instructions area, enter instructions to the operator about the job and click OK. 

These instructions can be displayed in Command WorkStation, but do not appear in 
the Job Log. These instructions can be edited by the operator.

9. Click the remaining print option bars to specify the appropriate settings for the print 
job and click OK.

These print options are specific to the E-820 and the copier. They override settings 
specified in E-820 Printer Setup, but can be overridden from the job management 
tools.

NOTE: The term “job management tools” is used in this manual to refer to Command 
WorkStation, Fiery Spooler, and WebSpooler.

For information about these options and overrides, see Appendix A. 

For information on configuring installable options, see the User Software Installation 
Guide.

For more information about job management tools, see the Job Management Guide.

If you choose Printer’s default, the job prints according to the settings specified in 
Setup. For more information, see Appendix A.

NOTE: If paper loaded in the selected tray is a different size, orientation, or media type 
than that of the job you are sending, the E-820 displays an error message and the job 
will not print. You should then load the correct paper in the selected tray or cancel the 
job.

NOTE: If you specify incompatible print settings, the Conflict dialog box provides 
instructions to resolve the conflict.

10. From your application, click OK.

Select the E-820 as your current copier.

11. Click OK.

NOTE: Some options listed in the printer driver could also be set from an application 
(for example, collation or Reverse Order). In these cases, use the driver option to 
perform the function, rather than setting it from the application. The application 
might not set up the file properly for printing on the E-820, which might cause an 
unexpected printing error, and might also take longer to process.
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TO SET DEFAULT PRINT OPTIONS FOR ALL WINDOWS PRINT JOBS USING THE 
ADOBE POSTSCRIPT PRINTER DRIVER

1. Click Start, choose Settings, and then choose Printers.

2. Right-click the E-820 icon and choose Properties (Windows 9x/Me), Document 
Defaults (Windows NT 4.0), or Printing Preferences (Windows 2000/XP).

3. Specify the default settings for your print job, as described on page 1-2.

Using saved settings
You can save print option settings to your hard disk so you can easily load specifically 
configured settings for a particular job. You can also share settings files over a network, 
using the Import and Export features.

TO CREATE SAVED SETTINGS

1. Make sure that Default Settings appears in the Saved Settings menu and configure 
options from the print option bars.

As soon as you change any settings, the Saved Settings menu displays Untitled instead 
of Default Settings.
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2. Click the Disk button.

3. Enter a Setting Name and click OK.

The name appears in the Saved Settings menu.

TO LOAD SAVED SETTINGS

1. From the Fiery Printing tab, click the Saved Settings menu.

2. Choose the settings you want to use.

The options are automatically configured with the saved settings.

Disk button Settings button
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TO DELETE SAVED SETTINGS

1. From the Fiery Printing tab, click the Settings button.

2. Choose the settings you want to delete and click Delete.

3. Click Yes to confirm the deletion and click OK.

TO MODIFY SAVED SETTINGS

1. From the Fiery Printing tab, click the Saved Settings menu.

2. Choose the settings you want to modify.

The options are automatically configured with the currently saved settings.

3. Configure your new settings from the print option bars and click the Disk button.

4. Click OK to save the modified settings.

TO EXPORT SAVED SETTINGS

1. From the Fiery Printing tab, click the Settings button.

2. Choose the Saved Settings you want to export and click Export.
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3. Browse to the location in which to save the file, enter a file name, and then click OK.

NOTE: The file name must include the .sav extension and can be up to eight characters 
(not including the extension). The file name does not have to match the Settings 
Name.

4. Click OK.

TO IMPORT SAVED SETTINGS

1. From the Fiery Printing tab, click the Settings button.

2. Click Import.

3. Browse to the location of the saved settings file you want to import.

4. Select the file you want to import and click OK.
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5. Click OK in the Settings dialog box.

NOTE: When you import saved settings, they appear in the Saved Settings menu under 
their Setting Name, not the file name. In the preceding examples, the file present.sav 
(file name) was imported, but it appears in the Saved Settings menu as Presentation 
(Setting Name).

Using Shortcuts
The Shortcuts area of the driver interface displays the current settings for some of the 
most commonly used print options. You can access and change these settings quickly 
and easily using the Shortcuts. You can also access some page layout and finishing 
options by right-clicking the image of the page directly below Shortcuts.

Print Option Shortcuts

Page Shortcuts
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TO SET PRINT OPTIONS USING SHORTCUTS

1. From the Fiery Printing tab, position your cursor over the print option you want 
to set.

The cursor will change into a hand.

2. Click the selected print option and specify the appropriate settings.

Alternatively, you can right-click the print option and specify the settings directly.

3. Click Apply to make the new settings the default.

4. Click OK.

TO SET PRINT OPTIONS USING THE PAGE SHORTCUTS

1. From the Fiery Printing tab, click the Finishing tab, position your cursor over the page 
image, and then right-click. 

2. Specify the appropriate settings for the print options.

3. Click Apply to assign the new settings as the default.

4. Click OK.

Defining and printing custom page sizes
With custom page sizes, you can define the dimensions of a printed page. After you 
define a custom page size, you can use it from within an application without redefining 
it each time you print. 

NOTE: Custom page sizes for Windows NT and Windows 2000/XP cannot be set using 
the Fiery Printing tab. For more information, see “Working with custom page sizes in 
Windows NT 4.0” on page 1-15 and “Working with custom page sizes in Windows 
2000/XP” on page 1-18.
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Working with custom page sizes in Windows 9x/Me
When you create custom page sizes, specify Width dimensions to correspond with the 
shorter side of your job and specify Height dimensions to correspond with the longer 
side of your print job. Set custom page sizes this way, regardless of the orientation 
settings in the application.

NOTE: Custom page sizes are not supported with Imposition jobs. 

TO DEFINE A CUSTOM PAGE SIZE WITH THE WINDOWS 9X/ME 
PRINTER DRIVER

1. Click Start, choose Settings, and then choose Printers.

2. Right-click the E-820 icon and choose Properties.

3. Click the Fiery Printing tab and click the Paper Source print option bar.

Height

Width

Width

Height

Portrait Landscape
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4. Click Custom.

The Enter Custom Paper Size dialog box appears.

5. Specify options to define the custom page size. 

Width—Enter the width of the print job.

Length—Enter the length of the print job.

Units—Select a unit of measurement for the print job.

Transverse—Select this option to swap Width and Length dimensions to correspond 
to the paper feed direction of the print job.

Paper name—Enter a name for your custom page size. The new custom paper name 
appears in the Document Size menu.

Click Custom
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6. Click OK.

7. To define the unprintable area of the custom page, click Unprintable Area, enter the 
desired information, and then click OK.

8. Click OK again.

TO EDIT A CUSTOM PAGE SIZE WITH THE WINDOWS 9X/ME PRINTER DRIVER

1. Click Start, choose Settings, and then choose Printers.

2. Right-click the E-820 icon and choose Properties.

3. Click the Fiery Printing tab and then click the Paper Source print option bar.

4. Choose the name of the custom page you want to edit from the Document Size menu.

5. Click Custom.

The Enter Custom Paper Size dialog box appears.

6. Edit the settings, as described on page 1-13, and click OK.

TO PRINT A CUSTOM PAGE SIZE WITH THE WINDOWS 9X/ME PRINTER DRIVER

1. Choose Print from your application.

2. Select the E-820 icon as the printer and click Properties.

3. Click the Fiery Printing tab, and then click the Paper Source print option bar.

4. Select Manual Feed from the Paper Source menu.

5. Select the custom page size from the Page Size menu.

6. Click the Layout print option bar and specify Landscape for Orientation.

7. Click OK and then click OK again to print the job.
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Working with custom page sizes in Windows NT 4.0
With custom page sizes, you can define the dimensions of a printed page. After you 
define a custom page size, you can use it from within an application without redefining 
it each time you print. 

NOTE: The copier must be set to print custom page sizes.

TO DEFINE A CUSTOM PAGE SIZE WITH THE WINDOWS NT 4.0 
PRINTER DRIVER

1. Click Start, choose Settings, and then choose Printers.

2. Right-click the E-820 icon and choose Document Defaults.

3. Click the Page Setup tab.

4. Choose PostScript Custom Page Size from the Paper Size menu.
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The PostScript Custom Page Size Definition dialog box appears. 

5. Specify options to define the custom page size. 

Custom Page Size Dimensions—Enter the width and height of the print job.

Unit—Select a unit of measurement for the print job.

Paper Feed Direction—Choose the paper feed direction of the print job.

Paper Type—Select the type of paper for the print job.

Offsets Relative to Paper Feed Direction—Enter the offsets (margins) of the 
print job relative to the paper feed direction.

6. Click OK.

TO EDIT A CUSTOM PAGE SIZE WITH THE WINDOWS NT 4.0 PRINTER DRIVER

1. Click Start, choose Settings, and then choose Printers.

2. Right-click the E-820 icon and choose Document Defaults.
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3. Click the Advanced tab and select Paper Size from the Paper/Output settings.

4. Choose PostScript Custom Page Size.

The PostScript Custom Page Size Definition dialog box appears. If it does not 
appear, click Edit Custom Page Size.

5. Edit the settings, as described on page 1-16, and click OK.

TO PRINT A CUSTOM PAGE SIZE WITH THE WINDOWS NT 4.0 
PRINTER DRIVER

1. Choose Print from your application.

2. Select the E-820 as the printer and click Properties.

3. Choose PostScript Custom Page from the Document Size menu.

4. Click the Fiery Printing tab again, and specify Landscape for Orientation in the Layout 
print option bar.

5. Click OK and then click OK again to print the job.
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Working with custom page sizes in Windows 2000/XP
With custom page sizes, you can define the dimensions of a printed page. After you 
define a custom page size, you can use it from an application without redefining it each 
time you print. 

NOTE: Windows 2000 and Windows XP have a similar interface when setting options 
and printing. The following procedures use Windows 2000 illustrations with Windows 
XP differences noted.

TO DEFINE A CUSTOM PAGE SIZE WITH THE WINDOWS 2000/XP 
PRINTER DRIVER

1. Click Start, choose Settings, and then choose Printers.

2. Right-click the E-820 icon and choose Printing Preferences.

3. Click the Paper/Quality tab.

4. Click Advanced.
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5. Choose PostScript Custom Page Size from the Paper Size menu.

The PostScript Custom Page Size Definition dialog box appears.

6. Specify options to define the custom page size. 

Custom Page Size Dimensions—Enter the width and height of the print job.

Unit—Select a unit of measurement for the print job.

Paper Feed Direction—Choose the paper feed direction of the print job.

Paper Type—Select the type of paper for the print job.

Offsets Relative to Paper Feed Direction—Enter the offsets (margins) of the print job 
relative to the paper feed direction.

7. Click OK to close the PostScript Custom Page Size Definition dialog box.

8. Click OK to close the Advanced Options dialog box.

9. Click OK to close the Printing Preferences dialog box.

You can now specify the custom page size from an application.
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TO EDIT A CUSTOM PAGE SIZE WITH THE WINDOWS 2000/XP 
PRINTER DRIVER

1. Click Start, choose Settings, and then choose Printers.

2. Right-click the E-820 icon and choose Printing Preferences.

3. Click the Paper/Quality tab.

4. Click Advanced.

5. Choose PostScript Custom Page Size from the Paper Size menu.

The PostScript Custom Page Size Definition dialog box appears. If it does not appear, 
click Edit Custom Page Size.

6. Edit the settings, as described on page 1-19, and click OK.

TO PRINT A CUSTOM PAGE SIZE WITH THE WINDOWS 2000/XP 
PRINTER DRIVER

1. Choose Print from your application and select Properties.

2. Click the Paper/Quality tab.

3. Click Advanced.

4. Choose PostScript Custom Page Size from the Paper Size menu. 

5. Verify the custom page size settings and click OK.

6. Select Manual Feed from the Paper Source menu.

7. Click OK to close the Advanced Options dialog box.

8. Click the Layout tab, and specify Landscape for Orientation, and then click Apply.

9. Click OK to close the Printing Preferences dialog box.

10. Click Print.
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Saving files to print at a remote location
If you do not have an E-820 onsite, and are preparing files to take to a service bureau 
or other location, print the final files to the File port (as opposed to one of the local 
ports). You can also print to the File port to create a file to download using 
Fiery Downloader. For instructions on printing to the File port, see your Windows 
documentation.
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You can print to the E-820 just as you would print to any other printer from any 
application. Select the E-820 as the current printer in the Chooser, and then print the 
file from within the application.

Another way to print from a Mac OS computer is to download PostScript (PS), 
Encapsulated PostScript (EPS), Tagged Image File Format (TIFF), or Portable 
Document Format (PDF) files using Fiery Downloader. For supported file versions, see 
the User Software Installation Guide. For details on using Fiery Downloader, see 
Chapter 4.

Printing from applications
Before you can print to the E-820 from applications, you must select the E-820 in 
the Chooser. Then, using the Adobe PostScript printer driver and the correct printer 
description file, you can control many E-820 printing features by specifying job 
settings from print dialog boxes. 

To achieve the best printing results from specific applications, see the Color Guide 
and the Fiery Color Reference.

Selecting the E-820 in the Chooser
Before you print a job, make sure the E-820 is the currently selected printer.

NOTE: For information about setting up the E-820 in the Chooser, see the User 
Software Installation Guide.

TO SELECT THE E-820 AS THE CURRENT PRINTER

1. Make sure the E-820 is connected to the network and turned on.

2. Choose Chooser from the Apple menu.

3. Click the AdobePS icon to select it.

NOTE: Make sure AppleTalk is set to Active.

Chapter 2:
Printing 
from Mac OS 
Computers
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4. If your network is divided into zones, select the zone in which the E-820 is located.

5. Select the E-820 by <Server Name>_<Queue Name>_ from the “Select a PostScript 
Printer” list.

The names of all supported printers in the zone appear in the list on the right. 

NOTE: If your system administrator has not enabled the connection to the Print 
queue or the Direct connection, the corresponding names will not appear in this list. 
For example, if your site has an operator who controls the flow of print jobs from 
Command WorkStation, you may be able to print only to the Hold queue. For more 
information on enabling print connections, see the Configuration Guide.

6. Close the Chooser window.

The E-820 remains selected as the current printer until you select a new printer in 
the Chooser.
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Setting options and printing from Mac OS computers
In Mac OS applications, print options are set from both the Page Setup dialog box and 
the Print dialog box. For details on specific print options, see Appendix A. 

NOTE: Some default print options are set by the administrator during Setup. Contact 
the administrator or the operator for information on the current server default settings.

TO SET PRINT OPTIONS AND PRINT WITH THE ADOBEPS PRINTER DRIVER

1. Open a file and choose Page Setup from the application’s File menu.

2. In the dialog box that appears, choose Page Attributes. 

Select the E-820 as your printer.

NOTE: Page Setup dialog boxes vary across applications.

3. Select the Page settings for your print job.

4. Click OK.
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5. Choose Print from the application’s File menu.

6. Select the E-820 as your printer and specify settings for the print options displayed.

NOTE: Print dialog boxes vary across applications.

From the Paper Source menu, choose the paper tray for the job. For example, you can 
specify that the job be printed on paper in Tray 1.

The Paper Source selection is valid for the current job only.

NOTE: If paper loaded in the selected tray is a different size, orientation, or media type 
than that of the job you are sending, the E-820 displays an error message and the job 
will not print. Load the correct paper into the selected tray or cancel the job. 
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7. Choose Fiery Job Notes.

Enter user and job identification information for managing purposes, or whatever 
information is required at your site.

Enter the User ID in the Group Name field. The Group Name also appears in 
Command WorkStation, WebSpooler, and Fiery Spooler Job Log. 

The Administrator or Operator can edit the Group Name and Group Password from 
the Command WorkStation, WebSpooler, or Fiery Spooler Properties window. 

The information you enter in the Notes field can be viewed by the operator in 
Command WorkStation and also appears in the Job Log. It cannot be edited or 
deleted by the operator.

NOTE: Group Name and Group Password options are not available when printing to 
the Direct connection.

 For more information on Command WorkStation overrides, see the Job Management 
Guide.

Choose Fiery Job Notes 
from the pop-up menu



22-6 Printing from Mac OS Computers
8. Choose Printer Specific Options and specify the appropriate settings for your print job.

These print options are specific to the E-820 and the copier; you may have to scroll to 
see all the options. They override settings in E-820 Printer Setup, but can be changed 
from Command WorkStation, Fiery WebSpooler, or Fiery Spooler.

If you choose Printer’s default, the job prints according to the settings specified 
in Setup. 

For more information about these options and overrides, see Appendix A.

Some print options including Soft Collate, Soft Reverse Order, and Manual Duplex 
that are selectable from an application or Adobe PS printing features are similar to the 
print options available from the Printer Specific Options menu. In these cases, specify 
the print option from the Printer Specific Options menu. The application or Adobe PS 
printer driver may not set up the file properly for printing on the E-820, which may 
cause an unexpected printing error and may also take longer to process.

You can also set some print options from an application (for example, Reverse Order 
printing or Collation). In these cases, use the print option to perform the function, 
rather than setting it from the application. The application might not set up the file 
properly for printing on the E-820 and might take longer to process.

NOTE: If you specify incompatible print settings, a dialog box might appear. Follow the 
on-screen instructions to resolve the conflict.

9. To make the new settings the default settings, click Save Settings.

10. Click Print.

Choose Printer Specific Options 
from the pop-up menu
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Defining custom page sizes 
With custom page sizes, you can define page dimensions and margins. After you define 
a custom page size, you can use it from within an application, without redefining it 
each time you print. 

TO DEFINE A CUSTOM PAGE SIZE

1. Choose Page Setup from the application’s File menu.

2. For Paper, choose Custom.

3. Choose Custom Page Default.

4. Enter the page dimensions and margins.

5. To view the minimum and maximum sizes, click the PPD Limits menu.

If you enter invalid sizes, an error message appears. Click Cancel and enter sizes 
specified within the PPD Limits.

6. To save this custom page size, enter a name and click Add.

Saved custom page sizes appear in the menu of page sizes in the upper-right corner of 
the dialog box. To remove a saved custom page size, choose it from the menu and 
click Remove. 

7. Click OK.

Enter a custom page name

Custom page names
displayed here

Limits for selected dimension 
displayed here

Choose Custom Page Default
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TO EDIT A SAVED CUSTOM PAGE SIZE

1. Choose Page Setup from the application’s File menu.

2. Choose Custom Page Default.

3. Select the Custom Page Size name.

4. Edit the page dimensions and margins.

5. Click Add.

6. Replace the existing Custom Page name and click OK.

TO PRINT A CUSTOM PAGE SIZE

1. Choose Page Setup from the application’s File menu.

2. Choose Custom or the Custom Page Size name from the Paper menu.

3. Click OK.

4. Choose Print from your application’s File menu.

Specify your printing options.

5. Click Print.
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You can print to the E-820 directly from UNIX workstations. Jobs printed to the 
E-820 are sent to the Print or Hold queue and can be manipulated from Command 
WorkStation or from Windows and Mac OS computers on the network using 
Fiery WebSpooler or Fiery Spooler.

NOTE: If you print to the Hold queue, an operator must intervene from Command 
WorkStation, Fiery Spooler, or Fiery WebSpooler for the job to print; jobs sent to the 
Hold queue are spooled to disk and held.

For more information on using Command WorkStation, Fiery Spooler, or 
Fiery WebSpooler, see the Job Management Guide. 

The queue name and E-820 printer name are determined by your system 
administrator. Contact your system administrator for the names of your queues.

For information about setting up printing from TCP/IP, see your UNIX system 
documentation.

Printing to the E-820
You can use UNIX commands to print PostScript and text files to the E-820. In 
general, use basic print commands (lpr, lpq, lprm) to send print jobs to the E-820. 
For information about UNIX commands, see the UNIX manual pages or other 
documentation.

NOTE: Only PostScript and ASCII text files can be printed from UNIX.

TO PRINT FROM UNIX

• On a system running SunOS 4.1.x or another BSD-based variant, use the lpr command 
to send a job to the E-820, as follows:

lpr <-Pprinter> <-#copies> <filename>

Chapter 3:
Printing 
from UNIX 
Workstations
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For example, if the Print queue of your E-820 is named print_Server, your file is named 
Sample, and you want to print two copies, type:

lpr -Pprint_Server -#2 Sample

• On a system running Solaris 2.x or any System V implementation of UNIX, use the lp 
command to send a job to the E-820, as follows:

lp -d <printername> -n <copies> <filename>

For example, if the Print queue of your E-820 is named print_Server, your file is named 
Sample, and you want to print two copies, type:

lp -d print_Server -n 2 Sample

TO DISPLAY A LIST OF JOBS IN THE QUEUE

• On a system running SunOS 4.1.x or another BSD-based variant, use the lpq command 
to see printer jobs in the queue, as follows:

lpq <-Pprinter>

For example, if the Print queue of your E-820 is named print_Server, type:

lpq -Pprint_Server

Your workstation displays the contents of the queue.

• On a system running Solaris 2.x or any System V implementation of UNIX, use the 
lpstat command to see printer jobs in the queue, as follows:

lpstat -o <printername>

For example, if the Print queue of your E-820 is named print_Server, type:

lpstat -o print_Server

Your workstation displays the contents of the queue.
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TO REMOVE JOBS FROM THE QUEUE

NOTE: Unless you log in as the root user, you can remove only your own jobs. 

• On a system running SunOS 4.1.x or another BSD-based variant, use the lprm command 
to remove jobs from the queue, as follows:

lprm <-Pprinter> <job #…>

You can use the lpq command to check the job number.

For example, to remove job number 123 from the Print queue of your E-820 named 
print_Server, type:

lprm -Pprint_Server 123

The lprm command reports the names of any files it removes.

• On a system running Solaris 2.x or any System V implementation of UNIX, use the 
cancel command to remove jobs from the queue.

cancel <printername> <job ID>

For example, to remove job number 123 from the Print queue of your E-820 named 
print_Server, type:

cancel print_Server 123
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Fiery Downloader and Fiery WebDownloader allow you to send PostScript (PS), 
Encapsulated PostScript (EPS), Tagged Image File Format (TIFF), and Portable 
Document Format (PDF) files directly to the E-820 without using the application in 
which they were created. It also allows you to manage printer fonts on the E-820.

You can use Fiery Downloader or Fiery WebDownloader from a remote workstation. 
Fiery Downloader and Fiery WebDownloader require a network connection. For 
information on installing and configuring Fiery Downloader and 
Fiery WebDownloader on supported networking protocols, see the User Software 
Installation Guide.

NOTE: The Windows and Mac OS version of Fiery Downloader and 
Fiery WebDownloader are fundamentally the same; differences are noted in this 
section. Where both windows or dialog boxes are illustrated, the Windows version 
comes first, followed by the Mac OS version.

You can also download files and fonts by using the Import feature in Command 
WorkStation. For more information, see the Job Management Guide.

Using Fiery Downloader and/or Fiery WebDownloader
You can use Fiery Downloader to do the following:

• Check the status of the E-820.

NOTE: This function is not available using Fiery WebDownloader, but it is available 
through the EFI Fiery WebStatus.

• Print PostScript, EPS, TIFF, and PDF files to the E-820. For supported file versions, 
see the User Software Installation Guide.

• Manage the printer fonts stored on the E-820 hard disk (this feature requires that 
the Direct connection be published on the E-820).

NOTE: Fiery Downloader does not work with Direct connection.

NOTE: Fiery Downloader and Fiery WebDownloader are designed specifically for the 
E-820; you cannot use them with any other printer. 

Chapter 4:
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TO VIEW INFORMATION WITH FIERY DOWNLOADER

1. Double-click the Fiery Downloader icon or choose Fiery Downloader from the 
Start >Programs menu.

2. Select the E-820 in the Chooser window and click OK (Windows) or Connect (Mac OS). 

The Fiery Downloader Status window appears, displaying the Fiery Downloader 
toolbar, menus, and status bar. 

Displays server status and user 
and document name of the job 
currently processing 

Dynamically displays the progress 
of the job

Displays the amount of available 
disk space

Displays server status and user 
and document name of the job 
currently printing
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Buttons for some menu functions appear in the toolbar at the top of the window. 

3. To view font information in the window, click the Font List button or choose Font List 
from the File menu.

Open Click to connect to a different E-820.

Download Click to download a file or font to the E-820.

Status If you are viewing the Font List, click to display 
the status window for the current E-820. 

Font List If you are viewing the status window, click to 
display a list of printer fonts on the E-820 
hard disk.

About Fiery 
Downloader 
(Windows only)

Click to view version information about Fiery 
Downloader.

Dynamically displays the progress 
of the job

Displays the amount of available 
disk space

Displays server status and user 
and document name of the job 
currently printing

Displays server status and user 
and document name of the job 
currently processing 
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4. To select a different E-820, choose Open from the File menu or click the Open button.

5. Select the E-820 in the dialog box that appears and click OK (Windows) or 
Connect (Mac OS).

6. To close the status window, choose Close from the File menu. To quit Fiery Downloader, 
choose Exit (Windows) or Quit (Mac OS) from the File menu.

7. Click Download.

Downloading printer fonts
You can download a variety of file types, as well as fonts, to the E-820. You can specify 
a limited number of print option settings for the files you download.

TO DOWNLOAD A FILE OR FONT WITH FIERY DOWNLOADER

1. Use your application to generate a file.

You can save a PostScript or PDF file by selecting the appropriate option in the 
application’s Print dialog box. With some applications, you can also save EPS and 
TIFF files.

If you experience problems printing EPS files with Fiery Downloader, you can print 
the file directly from the application in which you created it.

2. Start Fiery Downloader.
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3. Choose Download from the File menu or click the Download button.
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4. Choose the file type to display from the Files of type (Windows) or 
Show (Mac OS) menu.

All Known Formats lists all files in formats supported by Fiery Downloader.

You can download files and fonts in the same batch. If the fonts are used by files in the 
same batch, the fonts download first.

5. Choose the Connection Type (Windows) or Queue (Mac OS) to which you will download 
the files.

The options available to you in this menu depend on the setup at your site. The 
potential selections are Print Queue (Windows) or Print (Mac OS), Hold Queue 
(Windows) or Hold (Mac OS), and Direct Connection (Windows) or Direct 
(Mac OS). If your administrator has not enabled one or more of these connections, 
you cannot select it.

You cannot print PDF or TIFF files with the Direct connection. If you choose the 
Direct connection, the job is spooled to the Print queue and then printed. If the Print 
queue is not enabled, the job is spooled to the Hold queue and must be released for 
printing by the operator.

NOTE: To download fonts, you must use the Direct connection (make sure the 
Direct connection is published on the E-820). If you do not have access to the Direct 
connection, you must embed any special fonts used by the file in the file when you 
generate it.

6. Select the file name and click Add File(s) (Windows) or Add (Mac OS).

The File name field (Windows) displays the name of the selected file before you 
click Add.

You can navigate to different drives and directories to select files to download. 
Click Add All (Mac OS) to add all files in a folder.

To select multiple sequential files (Windows), select the first file and then Shift-click 
the last file. Control-click to select multiple non-sequential files.

If you change your mind about a file, select the file name in the Files to Download list 
and click Remove File(s) (Windows) or Remove (Mac OS).

Click Remove All (Mac OS) to remove all files from the Files to Download list.
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7. To change the attributes of a file to be downloaded, select it and click Options. 

8. Specify the following information in the dialog box and click OK.

The options you set apply only to the selected file. You can set different options, or 
leave the default settings, for each file.

Copies—Enter the number of copies.

Brightness (PostScript and EPS files only)—Change the Brightness setting if a file 
appears to be too dark or too light. Choose 85% for a substantially lighter image, 
115% for a substantially darker image, or one of the options in between. 

NOTE: Some applications, including Adobe Photoshop, provide transfer functions that 
allow you to specify density settings for an image. If the file you are printing includes 
transfer functions, the Fiery Downloader Brightness option has no effect. For more 
information on using transfer functions, see the documentation for your application.

‘showpage’ after EPS files (Windows) or ‘showpage’ (Mac OS) (PostScript and EPS 
files only)—In most cases, you do not need to use this option. Select the ‘showpage’ 
option only if an EPS file fails to print without it. This option adds a ‘showpage’ 
PostScript language command at the end of the print job. Some applications omit this 

PostScript Options dialog box (Windows) PDF Options dialog box (Windows)

PostScript Options dialog box (Mac OS) PDF Options dialog box (Mac OS)
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necessary PostScript language command when they generate EPS files. Select this 
option when printing EPS files generated by these applications. If you select this 
option unnecessarily, extra blank pages might print.

If you experience problems printing EPS files with Fiery Downloader, you can print 
the file directly from the application in which you created it.

Page range (PDF files only)—Specify the page range you want to print.

9. Click Download File(s) (Windows) or Download (Mac OS).

10. To cancel downloading, press Escape (Windows) or Command-. (Mac OS).

TO DOWNLOAD FILES OR FONTS USING FIERY WEBDOWNLOADER

1. Create a PostScript, EPS, TIFF, or PDF file. 

Specify the appropriate print options, and include (embed) any necessary fonts that are 
not resident on the E-820. For a list of fonts resident on the E-820, see Appendix B.

2. Start Fiery WebTools and click Fiery WebDownloader. For more information on 
accessing Fiery WebTools, see page 9-1.

3. Select the print connection and the file you want to download.

Managing printer fonts
The E-820 includes 136 PostScript fonts; for a complete list, see Appendix B. 
In addition, two Adobe Multiple Master fonts are included and used for font 
substitution in PDF files.

Before downloading a file that uses fonts not resident on the E-820, you must 
download the fonts (unless the fonts are embedded in the file). To see what fonts are 
resident on the E-820, choose Font List from the File menu or click the Font List 
button (see page 4-10).

You can download fonts only via the Direct connection. If you do not have access to 
the Direct connection, you must embed any special fonts used by the file when you 
generate it.
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The screen fonts that correspond to the printer fonts installed on the E-820 are not 
automatically installed on your Windows system.

NOTE: Fiery Downloader cannot download TrueType fonts. If you use TrueType fonts 
in Windows, convert them to Adobe Type 1 before printing. To convert to Adobe 
Type 1 fonts for Windows 9x/Me, click the Fonts tab in the Adobe PS printer driver 
and setup the Font Substitution Table. For Windows NT 4.0/2000/XP, click the 
Postscript tab of the E-820 Document Defaults dialog box and select TrueType Font 
Setting >Download as Softfont.

Printer fonts and Mac OS screen fonts 

Like all PostScript fonts, the fonts included with the E-820 come in two forms: printer 
fonts and screen fonts. Install the screen fonts included with the E-820 user software 
on your Mac OS computer. If you are using these fonts in documents you print on a 
LaserWriter, they are probably already installed. If not, you must install them. For 
more information, see the User Software Installation Guide.

Occasionally, you may want to use Adobe Type 1 (Windows) or PostScript (Mac OS) 
fonts that are not included with the E-820. If so, you must install both the screen fonts 
and the printer fonts on your computer. To do this, follow the instructions from the 
font manufacturer.

Downloading printer fonts to the E-820

In general, each time you print from within a Mac OS application, the application 
automatically downloads any fonts used in your document that are not already 
installed on the E-820, as long as the printer fonts are installed in your System Folder. 
These fonts remain in the E-820 only until your document has printed. If you print 
the same document again, your application must download the fonts again.

If you regularly use one or more fonts from Windows or Mac OS applications that are 
not already installed in the E-820, you can save time by downloading them to the 
E-820 hard disk with Fiery Downloader. Fonts you download to the E-820 hard disk 
remain installed until you remove them using Fiery Downloader, no matter how many 
times the E-820 is turned off and on. Consider downloading fonts you use on a regular 
basis to the E-820 hard disk.
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Before you download PostScript, TIFF, or EPS files with Fiery Downloader, make 
sure all fonts included in your file are installed on the E-820 or embedded in your file; 
otherwise, the text in these fonts will not print correctly or may not print at all. 
For PDF files, font substitution occurs automatically for fonts not installed on 
the E-820. Two multiple master fonts (a serif font and a sans serif font) stored on the 
E-820 are used exclusively for substitution with PDF files.

TO VIEW FONT INFORMATION, UPDATE, PRINT, AND DELETE FONTS

• Choose Font List from the File menu, or click the Font List button.

NOTE: If the Direct connection is not published, you cannot view the Font List or 
perform any of the tasks described in this procedure. For information on how to 
publish the Direct connection, see the Configuration Guide or consult your 
administrator.

The Font List window includes Update, Print, and Delete buttons. The printer fonts 
included with the E-820 (resident fonts) are locked. Locked fonts appear with a Lock 
icon next to the name and cannot be deleted.

Click to update the information 
in the Font List window

Click to print the Font List to the Print queue

Lock icon

Select a font and click here to delete it
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This chapter describes the variable data printing features supported by the E-820, 
including:

• Background information about variable data printing

• Printing variable data documents using EFI Fiery FreeForm™ and EFI Fiery 
FreeForm 2 

About variable data printing
Variable data printing is typically used for direct-mail advertising or other targeted 
mailings. It involves combining a set of master elements that are common across copies 
of a document with a set of variable elements that change from copy to copy. An 
example is a brochure that greets customers by name and may include other personal 
information about the customer obtained from a marketing database. Background 
elements, illustrations, and text blocks that do not change across copies of the brochure 
comprise the master elements. The customer’s name and other customer-specific 
information comprise the variable elements.

The E-820supports the following methods of variable data printing:

• The FreeForm feature allows you to use print options to define and store 
master-element documents—called FreeForm masters—on the E-820. You can send 
a variable-element job to the E-820 with instructions to combine the job with a 
particular FreeForm master.

• The FreeForm 2 feature allows you to assign specific page rules of a FreeForm master 
to each page of a variable job. To use FreeForm 2, you must create and print the 
variable job in a popular variable data printing application, such as PrintShop Mail.

• You can create the master and variable elements of a job in a popular variable data 
printing application, such as Pageflex Persona, and then print the job to the E-820 
through a supported file format. The E-820 is compatible with Creo VPS, and 
PPML variable data formats.

NOTE: PrintShop Mail-Fiery Version and Pageflex Persona-Fiery Version are options. 

Chapter 5:
Printing 
Variable Data 
Documents
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You cannot use the following print options and settings when printing variable data:

Combine Separations to On 
Compression to Off 
Optimize Power Point to On
Halftone Screen to any setting other than Contone

For more information, see Appendix A.

Printing variable data documents with FreeForm
In FreeForm variable data printing, you can use print options to define master 
documents and assign them to variable data jobs sent to the E-820.

How FreeForm works
The basic premise of FreeForm variable data printing is that the master-element data 
for the job can be sent to the E-820 and rasterized separately from the variable-element 
data. The master-element data is stored on the E-820 in rasterized form as a FreeForm 
master, and can be used as often as needed with multiple sets of variable-element 
data. Because the FreeForm master job is preRIPped and stored on the E-820, the 
only RIP time required for variable data print jobs is the time needed to RIP the 
variable-element data. You can use FreeForm masters for any fixed-element data you 
might combine with different data from day to day. For example, a letterhead template 
can be stored as a FreeForm master and used repeatedly as the background for different 
letter content (the variable-element data).

FreeForm allows you to create the master and variable documents using any 
application. You can create the two documents using different applications or 
computer platforms. To create the masters document, you can use a page layout or 
graphics application. To create the variable document, you can use a word processing 
application that has a mail merge feature, a page layout application that supports 
scripting, or a database application.

FreeForm functions are controlled with two print options: Create Master and Use 
Master. You can set these options in the printer driver when you send a job, or instruct 
the operator to set them with job overrides from Command WorkStation, Fiery 
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Spooler, or Fiery WebSpooler. You can also use Command WorkStation to monitor 
and manage all the FreeForm masters stored on the E-820. For more information, see 
the Job Management Guide.

Creating the master document
Before you can use FreeForm, you must create a master document and a variable 
document. This includes creating the layout for the combined document, as well as the 
elements themselves. In a page layout or graphics program, you arrange the master 
elements (text and graphics that do not change) on one or more pages, leaving space 
for the variable elements.

When you have finalized the design of the master document, print it to the E-820 and 
specify that a FreeForm master be created from the job (see page 5-8). 

Space for variable elements

Unchanging master elements

Master document
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NOTE: Although the E-820 can store up to 100 FreeForm masters, the printer driver 
interface, Fiery WebSpooler, and Fiery Spooler allow you to select numbers 1 through 
15 only. To create a FreeForm master with a number greater than 15, the operator 
must set the Create Master and Use Master options and RIP the job from Command 
WorkStation.

Creating the variable document
You can create the variable document with a word processing application that provides 
a mail merge function, a database application, or a page layout application that 
supports scripting. In all cases, information is taken from a list or database and merged 
into an existing document that is set up to accept the information. Each application 
has different controls for this function; for detailed instructions, see the application 
documentation. Before the variable elements can be added to the master document, 
they must be formatted to conform to the layout of the master document. To do this, 
you create a document with the correct formatting, and then add the variable 
information in the appropriate places. 

For efficient variable data printing, create a variable document that has significantly 
more pages than its corresponding FreeForm master.

Variable document

Variable element
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When you have created a variable document, print it to the E-820 and specify that it 
be combined with the corresponding FreeForm master (see page 5-8).

Combining the FreeForm master with the variable document
When you print a variable document to the E-820, you specify the FreeForm master 
created from your master document with the Use Master print option. The E-820 
combines the raster data of the variable document with the already RIPped FreeForm 
master, creating a new raster data file. The merged raster file can be soft-proofed 
(before it is printed) in the thumbnail windows of Command WorkStation, Fiery 
Spooler, or Fiery WebSpooler.

For more information about soft-proofing and thumbnail windows of Command 
WorkStation, see the Job Management Guide.

Combined document
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A master document can include more than one page. When you print a variable 
document and specify a FreeForm master that contains multiple pages, the variable 
pages are combined with the master pages in a cyclical fashion. The following example 
illustrates how a variable document combines with a two-page master document. 
Pages 1 and 2 of the variable document are combined with Pages 1 and 2, respectively, 
of the master document. The cycle of master pages then starts over, and Pages 3 and 4 
of the variable document are combined respectively with Pages 1 and 2, again, of the 
master document. This pattern continues for each subsequent set of pages in the 
variable document.

Multiple-page master document

Variable document

Combined document
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Using FreeForm
This section provides some suggestions to help you print variable data jobs correctly.

• Consult your administrator or operator on how FreeForm master numbers are 
assigned at your site.

If FreeForm printing is used by a large number of users at your site, FreeForm master 
numbers, or ranges of numbers, can be assigned to specific users or groups. Users can 
select only numbers 1 through 15 as print option settings. The operator can override 
FreeForm master numbers and reassign them to numbers greater than 15 from 
Command WorkStation. You may want the operator to assign all FreeForm master 
numbers to avoid potential conflicts in the use of FreeForm master numbers.

• Use the Job Notes and Instructions fields to communicate instructions about your 
job to the operator.

If you want to create or use a FreeForm master number greater than 15, these fields 
can be used to tell the operator to override the appropriate job setting (Create 
Master or Use Master) and RIP the job from Command WorkStation.

• Give your jobs unique and descriptive names.

Both you and the operator must be able to easily identify your jobs if there are many 
jobs in the queues, the FreeForm master numbers are reassigned, or you want to 
refer to another job in the Job Notes or Instructions fields.

• For restrictions on print option settings when using FreeForm, see Appendix A.

The following settings for the master document and variable document must match:

Color Mode
Page Size

The following settings for the variable document might override the corresponding 
settings in the master document:

Duplex
Media Type
Paper Source

Save Fast Reprint
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Black Detection
Copier Mode
Page Order
Sorter Mode
Stapler Mode

NOTE: The Top-Bottom print option of the Duplex setting will have no effect when 
printing using FreeForm.

TO PRINT VARIABLE DATA DOCUMENTS

1. Create a master document.

The following example shows one page of a master document for a tri-fold brochure 
that was created with a page layout application.

2. Print the master document to the E-820 with the Create Master print option set to one 
of the FreeForm Master numbers (1 through 15).

Or, set the Create Master option to None and instruct the operator to use overrides to 
create a FreeForm master from this job.
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3. Create the variable document.

You can create the variable document using a different file, a different application, or a 
different computer platform than was used to create the master document, but some 
print options must be the same (see page 5-7 for details).

The following example shows one page of the variable document for the tri-fold 
brochure. The data in this document can be as simple as a name and address, or as 
complex as multiple, full-color graphics and photographic elements.

4. Print the variable document to the E-820 with the Use Master print option set to the 
appropriate FreeForm master number.

The FreeForm master number may be one you set when you sent the master 
document, or one that was assigned by the operator.

If you want to check the job before it prints, instruct the operator to RIP and Hold the 
job so you can preview it from Command WorkStation, Fiery Spooler, or 
Fiery WebSpooler.
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The following example shows the FreeForm master and variable document combined. 
The variable data is simply overlaid on the master document.

Printing variable data documents with FreeForm 2 
Freeform 2 extends the functionality of variable data documents using a third-party 
application that supports FreeForm 2 such as PrintShop Mail which allows you to 
create and print variable data documents. 

To print a variable data job using FreeForm 2, you first open the variable document 
in the third-party application. The third-party application provides FreeForm 2 
features that allow you to assign a specific page of a FreeForm master to each page of 
the variable document.

Freeform 2 enables you to specify page conditions that determine rules for individual 
Master pages. These rules, described by if and then statements in each Master page, can 
allow you to skip or print pages within a Master file. For more information on creating 
page conditions, see the documentation that came with the third-party printing 
software.
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For instructions on creating a variable data job or printing variable data jobs using 
FreeForm 2 and the third-party variable data printing software, see the documentation 
that came with the third-party printing software.

FreeForm 2 also provides the option to delete a specified FreeForm master from the 
E-820 hard disk after its corresponding variable job has been successfully RIPped and 
printed. You can set this feature in a third-party application that supports the clearing 
of FreeForm masters. For more information on deleting FreeForm masters, see the 
documentation that came with the third-party printing software.

Printing documents from variable-data printing 
applications 
As an alternative to FreeForm or FreeForm 2, you can design the master and variable 
elements of your job using a variable-data printing application, such as Pageflex 
Persona. You can then print the job to the E-820 from the application using a 
compatible file format. The E-820 is compatible with the following variable data 
formats:

• CreoVPS (Variable Print Specification)

• PPML (Personalized Print Markup Language) 

PPML is a variable data standard that supports the use of multiple graphic objects as 
both variable and master elements. 

NOTE: Printing documents from variable-data printing applications is an 
optional feature.

To print documents in PPML format, use a third-party software application that is 
compatible with PPML format, such Pageflex Persona or download a PPML file using 
Command WorkStation.

For more information on printing documents with variable-data formats, see the 
documentation that came with the third-party printing software. 

NOTE: Creo VPS or PPML files cannot be printed with the Direct connection.



55-12 Printing Variable Data Documents
Using the Fiery VDP Resource Manager
PPML jobs contain all the global objects for an environment created by an application 
such as PrintShop Mail. Global objects are the required images that are downloaded to 
the E-820 for PPML jobs with variable elements. These images are stored and cached 
as a group in an environment. The images can then be reused for future PPML jobs.

The global objects in each environment can be managed with the Fiery VDP Resource 
Manager utility. You can view all the installed global objects in the E-820 VDP cache 
area. For a project, all global objects are grouped under an environment name.

To install and configure the Fiery VDP Resource Manager, see the User Software 
Installation Guide. To view and delete global objects, use the following the procedure.

TO VIEW AND DELETE GLOBAL OBJECTS

1. Open the Fiery VDP Resource Manager utility.

2. Click the Fiery Servers folder to expand the list of available Fiery servers.

All connected servers are displayed.

3. Double-click the folder of theE-820 to display the list of PPML global object 
environments. 
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4. To delete global objects, click the global object environment and select Remove Cache 
and Source from the Actions menu. 

To delete the cache only and not the source, select Remove Cache from the 
Actions menu.

NOTE: To update the current information, select Refresh from the Server menu. Global 
objects cannot be deleted from the E-820 or with the Command WorkStation Clear 
Server command.
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With Fiery Scan, you can scan documents or images from the copier glass directly into 
Photoshop on your computer or through the copier’s automatic document feeder 
(ADF) using the Fiery Scan 3.x TWAIN module. With Fiery Remote Scan, you can 
display the scan in a host application, such as photoshop, and then retrieve and send 
the scan to a specific destination. You can also use EFI WebScan™ to retrieve a scan.

The following requirements and constraints apply:

• Fiery Scan and Fiery Remote Scan cannot be used over the parallel port; it requires a 
network connection. For information on supported networking protocols, see the 
User Software Installation Guide.

• Fiery Scan and Fiery Remote Scan must be installed as described in the User Software 
Installation Guide.

• Photoshop RGB Setup should use EFIRGB.icm (Windows) or EFIRGB ICC (Mac 
OS) settings. For information on loading this file, see the User Software Installation 
Guide.

Fiery Scan components 
Fiery Scan consists of the following software components and features:

• Fiery Remote Scan—includes the Fiery Scan 4.x TWAIN plug-in module. Fiery 
Remote Scan allows you to remotely initiate and retrieve a scan from a remote 
computer on the network to a copier.

• FieryBar Scan application—appears on the Fiery Advanced Controller Interface 
(option). FieryBar Scan allows you to initiate and send scan files taken from the 
copier.

• Fiery Scan 3.x TWAIN plug-in module. With the Fiery Scan plug-in module, you 
can scan an image from the copier glass directly into TWAIN compliant application 
software on your computer.

• Scan to E-mail

• Scan to mailbox

Chapter 6:
Scanning
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• Scan to Hold queue for document merging and editing

• Fiery WebScan for mailbox retrieval using Fiery WebTools 

Using Fiery Remote Scan
With Fiery Remote Scan, you can initiate and retrieve scan files remotely. You can 
open the scan file in a host application, such as Photoshop 5.5, Photoshop 6.0 or 
Acrobat 4.05, and send the scan file to a mailbox, the Hold queue, or an e-mail 
address. You can then retrieve files using Fiery Remote Scan, Fiery WebScan, or 
Command WorkStation. All scans are stored on the E-820 hard disk and retrieved 
through the network.

NOTE: The following procedures describe how to use Fiery Remote Scan from 
Photoshop 5.5 and Photoshop 6.0.

NOTE: The Windows and Mac OS versions of Fiery Scan are fundamentally the same; 
differences are noted in this section. Where illustrations from both platforms appear, 
the Windows version comes first, followed by the Mac OS version.

TO INITIATE A SCAN

1. Start Photoshop.

2. If you are scanning a single original, place it on the copier glass; if you are scanning 
multiple originals, place them in the document feeder.

3. In Photoshop’s File menu, choose Import. 

If you are using Photoshop 5.5, choose Import from the File menu, and then click 
TWAIN_32 (Windows) or Fiery Twain Acquire (Mac OS).

If you are using Photoshop 6.0 or later, choose Import frames File menu, and then 
click Fiery Remote Scan 4.4. for both Windows and Mac OS.

NOTE: On a Mac OS, do not select “Fiery Twain Acquire” from Photoshop 6.0.

4. Select Fiery Remote Scan 4.4 in the dialog box that appears, and click Select.

5. Choose Import from the File menu and click TWAIN_32.
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6. Select the E-820 in the Choose Device dialog box and click OK.

If the E-820 does not appear in the My Fiery list, you must configure the list to 
communicate with the E-820. For instructions, see the User Software Installation 
Guide.

7. Click the Initiate tab.
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8. Select the appropriate options in the Initiate tab.

Source—Choose ADF or Platen.

Sides—Choose the number of sides the copier must scan. 
(This option is only available if you are scanning from the document feeder.)

Size—Choose the size of the document the E-820 scans.
(This option is only available if you are scanning from the copier glass.)

Resolution—Choose a value for the resolution. Changing the resolution also changes 
the image size. The maximum resolution supported by the E-820 is displayed in the 
dialog box.

Color Mode (Color or Grayscale)—Choose the type of scan you want.

9. Click Acquire or Send.

If you click Acquire, the scan opens in the host application, where you can view and 
edit your scanned file.

If you want to save the file to a specific destination, click Send and see the procedures 
in the following section. 

Sending a scan job to a specific destination
When you initiate a scan, you select where to send the file. After selecting the 
appropriate settings for your scan job from the Acquire Jobs dialog box, you can 
specify the location to send the scan. You can send the scan to a mailbox, to the Hold 
queue, or an e-mail address.

NOTE: The name of the application displayed in the dialog box title bar varies, 
depending on the application you are using.
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Using Scan to Hold queue for document merging and editing

When you send a scan file to the Hold queue, the E-820 automatically converts and 
stores the file as a PDF on the E-820 hard disk. You can then manipulate the file using 
DocBuilder Pro and Command WorkStation. For information about using 
DocBuilder Pro, see the Job Management Guide.

TO SEND A SCAN FILE TO THE HOLD QUEUE

1. In the Acquire Jobs dialog box, select the appropriate settings for your scan job 
and click Send.

2. Select Fiery Hold queue to save the file as a PDF in the local Hold queue.

The scan job will appear in the Spool area of the Command WorkStation Queues 
window.

Scan to Mailbox

You can save the scan file to a four-digit mailbox on the E-820 hard disk. 

TO SEND A SCAN FILE TO A MAILBOX

1. In the Acquire Jobs dialog box, select the appropriate settings for your scan job 
and click Send.

2. Select Mailbox.

3. Enter the Mailbox number.

4. Click Send.
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Scan to E-mail

You can send a scanned image via e-mail, as either an attachment or a URL. For more 
information on E-mail services, see Chapter 10.

TO SEND A SCAN FILE TO AN E-MAIL ADDRESS

1. In the Acquire Jobs dialog box, select the appropriate settings for your scan job 
and click Send.

2. Select the E-mail option and click Edit Email (Windows) or Edit E-mail Destination 
(Mac OS).

The E-mail message window appears.

3. To send a scan file, enter an e-mail address in the To: field, or browse the list of e-mail 
addresses in the Address Book by clicking To:, Cc:, or Bcc:. 

You can also enter a Subject line and body text. 

4. Click OK.

5. Indicate whether you want to send the file as an attachment or a URL.

6. Choose a File Format (JPG, PDF, or TIFF).

7. Click Send.
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Retrieving scan files
Once you have scanned a document to the mailbox, you can access the documents 
with Fiery Remote Scan or the Fiery WebScan. 

TO RETRIEVE SCAN FILES USING FIERY REMOTE SCAN

1. Start Photoshop.

2. Choose Import from the Photoshop File menu and click Select TWAIN_32 Source.

If you are using Photoshop 5.5, choose Import from the File menu, and then click 
TWAIN_32 (Windows) or Fiery Twain Acquire (Mac OS).

If you are using Photoshop 6.0 or later, choose Import from the File menu, and then 
click Fiery Remote Scan 4.4. for both Windows and Mac OS.

NOTE: On a Mac OS, do not select “Fiery Twain Acquire” from Photoshop 6.0.

3. Select Fiery Remote Scan in the dialog box that appears and click Select.

4. Choose Import from the File menu and click TWAIN_32.

5. Select the E-820 in the Chooser and click OK.

If the E-820 does not appear in the Windows Chooser, you must configure the 
Chooser to communicate with the E-820. For instructions, see the User Software 
Installation Guide.
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6. Click the Retrieve tab.
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7. Enter the Mailbox number for the scan file.

All scan jobs in the Mailbox are listed.

8. Select the specific scan job you want to open. 

To open all pages of a scan, select All; to open a specific page, select Page and enter the 
specific number in the Page field.

9. Click Acquire.

The scan job opens in Photoshop.

If you want to save and send the file to a specific destination, see “Sending a scan job to 
a specific destination” on page 6-4.

TO RETRIEVE SCAN FILES USING FIERY WEBSCAN

1. Click the WebScan WebTool from the Fiery WebTools menu.

The WebScan window appears.

2. Enter the Mailbox number in the Mailbox field.

NOTE: The Mailbox number is the directory you specified with the copier’s 
Scanner Mode. 
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3. Click Refresh.

All scanned documents in the Mailbox are listed.

WebScan lists the following information about each scanned job: File name, Date, 
Pages, File Size, Page Size, Resolution X, and Resolution Y. 

4. Select the file you want to open.

5. Choose PDF, TIFF, or JPEG from the File Format menu.

You can specify the pages you want to retrieve from your job if you choose JPEG from 
the File Format menu.

If you want to open all pages of a scan click All. If you want to open a specific page, 
specify the Page number to scan.

6. Click Save As.

NOTE: Depending the browser you are using, you may be asked to indicate whether 
you want to open the file from its current location, or save the file to disk.

The scanned image is displayed in your web browser.

NOTE: You must have Adobe Acrobat installed to view a scanned PDF.

7. To print the job, choose Print from the File menu.

To delete a scanned image from the E-820 hard disk, select the file you want to delete 
from the WebScan window and click Delete.
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NOTE: The Acquire and Send buttons on the Initiate Tab both initiate a scan. 
The Acquire command acquires the scan directly into the host application, such as 
Photoshop. The Send command sends the scan to all the destinations selected by the 
user, such as the Hold queue, a selected mailbox, or an e-mail recipient.

If you use Acquire to scan a document and then you want to send that scan to several 
destinations, you must leave (or replace) the document on the copier and then click 
Send.

Using the FieryBar Scan application (FACI option)
The FieryBar Scan application allows you to initiate and retrieve scans using the 
optional Fiery Advanced Controller Interface (FACI). The FieryBar Scan application 
user interface and procedures are similar to the Fiery Remote Scan interface for 
Windows, except you cannot acquire the scan in Photoshop.

TO INITIATE A SCAN USING THE FIERYBAR SCAN APPLICATION

1. Start the FieryBar Scan application from the Fiery Bar by right-clicking the application 
on the Fiery Advanced Controller Interface and selecting Scan.

2. Click the Initiate tab.
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3. Select the appropriate options in the Initiate tab.

Source—Choose ADF or Platen.

Sides—Choose the number of sides the copier must scan. 
(This option is only available if you are scanning from the document feeder.)

Size—Choose the size of the document the E-820 scans. 
(This option is only available if you are scanning from the copier glass.)

Resolution—Choose a value for the resolution. Changing the resolution also changes 
the image size. The maximum resolution supported by the E-820 appears in the 
dialog box.

Color Mode (Color or Grayscale)—Choose the type of scan you want.

4. Click Send.

To save the file to a specific destination, see “Sending a scan job to a specific 
destination” on page 6-4. 

To cancel scanning, select Cancel on the E-820 Control Panel.

NOTE: The Cancel button in the window will have no effect.

TO RETRIEVE A SCAN FILE USING THE FIERYBAR SCAN APPLICATION

1. Start the FieryBar Scan application from the Fiery Bar by selecting Scan.

2. Click the Retrieve tab.
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3. Enter the specific Mailbox number for the scan file.

All scan jobs in the Mailbox are displayed.

4. Select the specific scan job you want to open. 

To open all pages of a scan, click All; to open a specific page, enter the specific number 
in the Page field.

Scanning to the E-820 hard disk drive
Fiery Scan uses a scan to hard disk drive (HDD) feature that allows you to use the 
E-820 Control Panel to scan an image from the copier glass (platen) or document 
feeder (DF) into E-820 memory. You can then open the image with Fiery Remote Scan 
or the WebScan WebTool.

Additionally, you can scan a job directly to the Hold queue, so that you can use the 
DocBuilder Pro features of Command WorkStation. For more information on using 
DocBuilder Pro, see the Job Management Guide.

The following procedure explains how to scan to the HDD with the E-820 Control 
Panel. For information on using the Control Panel menu, see the Configuration Guide.

TO SCAN A JOB TO THE HDD USING THE E-820 CONTROL PANEL

1. Position the original face down on the copier glass or face up in the document feeder.

2. Make sure the information screen on the Control Panel reads Idle.

If Printing or RIPping appears, the E-820 is processing; you must wait until the system 
reaches Idle.

3. Press the Menu button on the Control Panel to go to the Functions menu.

4. Scroll with the down arrow.

5. Press the line selection button next to Scan Job.

6. Press the line selection button next to Source.

7. Choose your Document Source.
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Choose ADF if you are scanning from the document feeder or choose Platen if you are 
scanning from the glass.

NOTE: If ADF is selected and no paper is detected, an error message will prompt you to 
set the document in the document feeder.

8. Choose the Original Size of your scan job.

Select the paper size from the list box for paper size selection.

9. Specify if your job is one-sided or two-sided.

10. Press the line selection button next to Image Options.

11. Choose the Color Mode.

Choose either Color, Grayscale, or Black and White.

12. Choose the Resolution of your scan job.

Choose 150, 300, 600.

To select a scan file destination, see the following procedures.

Sending a scan job to a specific destination
When you initiate the scan, you select where to send the file. After you select the 
appropriate settings for your scan job using the previous procedure, you can specify the 
location to send the scan. You can send the scan to a mailbox, the Hold queue, or an 
e-mail address.

NOTE: You can send the scan to an e-mail address only if you have set up e-mail service 
in advance. For more information, see the Configuration Guide.

TO SEND A SCAN FILE TO THE MAILBOX 

1. After you have selected your settings, press the line selection button next 
to Destination.

2. Press the line selection button next to Add Destination.

3. Choose Send to Mailbox.

Enter a mailbox number from 0–9999.

4. Press the line selection button next to Exit Destination.
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5. Press the line selection button next to Start Scan.

6. Enter a file name for your job.

The default name is MMDDHHMMSS.

The job is scanned and the file is sent to the E-820 hard disk. To retrieve the scan file, 
see “Retrieving scan files” on page 6-8.

To cancel scanning, select Cancel on the E-820 Control Panel.

TO SEND A SCAN FILE TO THE HOLD QUEUE

1. After you have selected your settings, press the line selection button next to 
Destination.

2. Press the line selection button next to Add Destination.

3. Select Send to Hold Queue.

4. Choose Yes to send your job to Fiery Hold Queue.

5. Choose the line selection button next to Exit Add Dest.

6. Press the line selection button next to Exit Destination.

7. Press the line selection button next to Start Scan.

8. Enter a name for your job.

The default name is MMDDHHMMSS.

The job is scanned and the file is sent to the E-820 Hold queue. For information on 
retrieving jobs sent to the Hold queue, see the Job Management Guide.

To cancel scanning, select Cancel on the E-820 Control Panel.

TO MANUALLY SEND A SCAN FILE TO AN E-MAIL ADDRESS

1. After you have selected your settings using the previous procedure, press the line 
selection button next to Destination.

2. Press the line selection button next to Add Destination.

3. Press the line button next to Send to Email.
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4. Press the line selection button next to Select Addresses.

5. Press the line selection button next to New Address.

Enter the e-mail address by specifying the user and domain name. 

6. Choose Exit Email Address.

7. Press the line selection button next to Configure Email.

8. Choose Attachment or URL as a Document Format.

9. Choose PDF, TIFF, or JPEG as a File Format.

NOTE: Multiple JPEG images in a single file are not supported.

10. Press the line selection button next to Exit Email.

11. Press the line selection button next to Exit Add Dest.

12. Press the line selection button next to Exit Destination.

13. Press the line selection button next to Start Scan.

14. Enter a name for your job.

The default name is MMDDHHMMSS.

The job is scanned and the file is sent to the e-mail address. 

To cancel scanning, select Cancel on the E-820 Control Panel.

TO SEND A SCAN FILE USING THE ADDRESS BOOK

1. After you have selected your settings, press the line selection button next to 
Destination.

2. Press the line selection button next to Add Destination.

3. Press the line selection button next to Send to E-mail.

4. Press the line selection button next to Select Addresses.

5. Press the line selection button next to Fiery Address Book.
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6. Press the line selection button next to the alphabetized category for the 
e-mail address.

The e-mail addresses are alphabetized by the first letter of the e-mail address.

7. Choose the e-mail addresses.

8. Choose Exit Address Book.

If you want to remove an e-mail address before you send the scan file, select 
Remove Addresses and press the line selection of the e-mail address you want to delete. 
Click OK.

9. Press the line selection button next to Exit Email Address.

10. Press the line selection button next to Configure Email.

11. Choose Attachment or URL as a Document Format.

12. Choose PDF, TIFF, or JPEG as the File Format.

NOTE: Multiple JPEG images in a single file are not supported.

13. Press the line selection button next to Exit Email.

14. Press the line selection button next to Exit Add Dest.

15. Press the line selection button next to Exit Destination.

16. Press the line selection button next to Start Scan.

17. Enter a name for your job.

The default name is MMDDHHMMSS.

The job is scanned and the file is sent to the e-mail addresses from the address book. 

To cancel scanning, select Cancel on the E-820 Control Panel.
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Using Fiery Scan 3.x
The following requirements and constraints apply:

• The Fiery Scan plug-in must be installed as described in the User Software 
Installation Guide.

• In Photoshop’s RGB Setup, use the EFIRGB ICC (Mac OS) or EFIRGB.icm 
(Windows) settings. For information on loading this file, see the User Software 
Installation Guide.

Fiery Scan color conversion settings
Fiery Scan offers two color conversion choices for scanned data:

• Calibrated RGB creates an RGB scan optimized for printing with E-820 Rendering 
Styles (CRDs) or ICC profiles, as well as for viewing on the monitor.

• Match Copy creates a CMYK scan that, when printed on the E-820, looks like a copy 
of the original made with the copier.

NOTE: When you print an image scanned in grayscale, the image might output in 
colors, depending on the application.

Scanning from the copier
With Fiery Scan, you first create a prescan of the image; then you can select part, or all, 
of the prescan for final scanning.

NOTE: The Windows and Mac OS versions of Fiery Scan are fundamentally the 
same; differences are noted in this section. Where both windows or dialog boxes are 
illustrated, the Windows version comes first, followed by the Mac OS version.

NOTE: The following procedure describes scanning from Photoshop.



66-20 Scanning
TO PRESCAN A DOCUMENT

1. Start Photoshop.

2. Place the original you want to scan on the copier glass.

3. If you are using Photoshop 5.5, choose Import from the File menu, and then click 
TWAIN_32 (Windows) or Fiery Twain Acquire (Mac OS).

If you are using Photoshop 6.0 or later, choose Import from the File menu, and then 
click Fiery Scan 3.4. for both Windows and Mac OS.

NOTE: On a Mac OS, do not select “Fiery Twain Acquire” from Photoshop 6.0.

4. Select Fiery Scan in the window that appears, and click Select (Windows) or OK 
(Mac OS).

5. Choose Import from the File menu and click TWAIN_32 (Windows) or Fiery Twain 
Acquire (Mac OS).

NOTE: On a Mac OS, do not select “Fiery Scan” from Photoshop 6.0.

6. Select the E-820 in the Chooser window, and click OK (Windows) or Connect (Mac OS).

If the E-820 does not appear in the Windows Chooser list, you must configure the 
Chooser list to communicate with the E-820. For instructions, see the User Software 
Installation Guide.

7. Select the appropriate settings in the Fiery Scan dialog box.

Prescan size—Choose the paper size of the original. 

Resolution—Specify a value for the resolution. Changing the resolution also changes 
the image size. The maximum resolution supported by the E-820 appears in the dialog 
box.

Scan Mode (Full Color, Grayscale, or Black & White)—Specify the type of scan.

8. Click Prescan.

The prescan image appears on the left side of the dialog box. 

NOTE: After prescanning, you must complete the scan before the E-820 is able to begin 
RIPping and printing any new jobs.
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TO SELECT OPTIONS AND COMPLETE THE SCAN

1. Drag the cursor to select the area of the prescan image that you want to acquire, or 
enter the area to acquire in the Selection area.

In the Selection area, you can specify:

Units (inches, centimeters, picas, points, ciceros, or pixels)—Specify the ruler units 
that appear around the preview image.
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Width and Height—Enter the width and height of the area to scan; or, select an area of 
the page with the selection marquee. If you use the marquee to select the scan area, the 
dimensions appear in these text boxes. If you do not specify a scan area, the default is 
to acquire the entire scan.

To select a portion of the image using the marquee, you can move the selection 
marquee around by positioning the Hand tool inside the marquee and dragging the 
marquee to a new location. You can change the size of the frame by clicking and 
dragging one of the handles on the corners of the selection frame. If you want to 
deselect the area you have selected, double-click anywhere. 

The E-820 scans at a maximum resolution that is dependent on the size of the selected 
area. When you select an area to be scanned, Fiery Scan displays the maximum 
resolution possible for that area. You can enter a dpi value which is less than the 
maximum resolution.

2. Click Options to display the Fiery Options dialog box (Windows) or Scan Options 
dialog box (Mac OS). 

Original—Select the resampling interpolation method to use. In general, you should 
choose Photograph if you are scanning a continuous tone photographic image and 
Offset Print or Copy if you are scanning a printed document. The Offset Print or 
Copy mode takes slightly more time but reduces moiré patterns in scans. 
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Color Conversion—Use Calibrated RGB if you will print the image using a E-820 
Rendering Style (CRD). Use Match Copy to match the colors in a copy made by the 
copier as closely as possible, assuming that you are going to print the image to the same 
copier and you do not want to use a Rendering Style (see “Fiery Scan color conversion 
settings” on page 6-19). 

3. Select the appropriate settings and click OK.

4. Click Scan in the main window to acquire the scan.

The progress bar displays how much of the image has been processed. You can press 
Esc (Windows) or Command-. (Mac OS) to cancel acquiring the scan.

When the scan is acquired, the scanned image is displayed in Photoshop.
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This chapter describes how to use the EFI Converter application to convert 
TIFF/IT-p1 files to PS or EPS file formats. EFI Converter is a feature of the
Fiery Graphic Arts Package, which allows input of TIFF/IT files to RIP through 
a Hot Folder.

NOTE: The EFI Converter is supported on Windows 9x/Me and 
Windows NT 4.0/2000/XP.

TIFF/IT file formats
TIFF/IT-p1 is a common file format for the transfer of final print job data from one 
print platform to another. It is a widely used format for prepress preparation in 
traditional printing environments.

The TIFF/IT-p1 file format refers to a series of files. All TIFF/IT-p1 files contain a 
.fp file. The .fp file provides information about required subfiles, which may include 
.ct, .lw, and .hc files.

File format File format abbreviation

Continuous Tone .ct

Linework .lw

High-resolution Contone .hc

Final Page .fp
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Using EFI Converter
The EFI Converter application monitors incoming conversion jobs on your computer 
when you drag and drop files onto the Control Panel or an Input Folder.

The EFI Converter Control Panel allows you to configure conversion parameters and 
create and manage all your folders.

TO START THE EFI CONVERTER APPLICATION AND DISPLAY 
THE CONTROL PANEL

• Start EFI Converter by double-clicking the application icon in Programs > Fiery 
>EFI Converter.

NOTE: To install the Fiery Graphic Arts Package, see the User Software Installation 
Guide.

Setting EFI Converter preferences
You can specify several preferences for the EFI Converter, including resolution, 
compression, default input folder location for retrieving source files, and output folder 
location for storing converted files.

The Input Folder allows you to drag and drop files onto the folder to convert 
them. The folder can be shared across the network so other users have access to 
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the conversion process without running the converter application on their local 
computers. The Input Folder can also be used as temporary storage for pending 
conversion jobs.

If you specify an Input Folder, you must also create an Output Folder. The Output 
Folder stores all successfully converted PS or EPS files. Hot Folders can monitor the 
Output Folder and transfer files automatically to the E-820. For more information on 
Hot Folders, see “Using EFI Hot Folders (Fiery Graphic Arts Package option)” on 
page 8-1.

NOTE: You can create an Output Folder without creating an Input Folder since there 
are several ways of converting files. For more information, see “Converting files” on 
page 7-5.

TO SET PREFERENCES 

1. Choose Preferences from the Options Menu.

The Preferences dialog box appears.

Resolution—Select 200, 400, or 600 dpi.

Anti-Aliasing—Select Nearest Neighbor (Faster) or Bilinear (Better). 

Compression—Select Lossless. 
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Output Type—Choose PostScript or EPS.

NOTE: If the source file contains spot color, it can only be converted to PostScript. 

Reduce or Enlarge— Enter a percentage. (PostScript Options are enabled if PostScript 
is selected as the Output Type, ignored during conversion if EPS is selected.) 

Orientation—Choose Always Portrait, Always Landscape, or Keep Original 
Orientation.

2. Click OK.

TO CREATE INPUT/OUTPUT FOLDERS

1. In the Preferences dialog box, under Input/Output Folders, click Browse for 
Input Location or Output Location. 

The Browse for Folder dialog box appears.
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2. Select an existing folder or navigate to the location where you want to create a new 
Input/Output folder. Click OK.

NOTE: You cannot use the following folder types as Input/Output folders:

• The System Folder of your computer

• The Desktop Folder of your computer

• Folders located on a root directory (for example, c:\)

• Folders located on network drives, such as a common file server (unless the EFI 
Converter application is installed and running locally on the file server)

3. Click OK.

The new Input and Output folders are ready for use.

Converting files
To convert files with the EFI Converter, do any one of the following:

• Drag and drop files on the EFI Converter application main window. 

• Choose Convert from the Options menu. 

• Drag and drop files onto the Input Folder.

If you have specified an Output Folder, the converted files are stored in the Output 
Folder. If you have not specified an Output Folder, the converted files are stored in the 
same directory as the original input file.

The conversion process will not start if you have invalid file types or if you are missing 
subfiles. All required subfiles must be complete when converting a file.

NOTE: The EFI Converter converts files containing any spot color into the PS file 
format only. CMYK files will only be converted into PS or EPS file formats.
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TO CONVERT FILES BY DRAGGING AND DROPPING FILES ONTO THE 
CONVERTER MAIN WINDOW OR THE INPUT FOLDER

• Drag and drop the files onto the EFI Converter window or the Input Folder. 

The conversion process starts once you select and drag all necessary files (.ct, .lw, .hc, 
.fp). You will see the files being converted in the EFI Converter window.

TO CONVERT FILES USING THE CONVERT COMMAND

1. Choose Convert from the Options menu.

2. Open the .fp file you want to convert. 

The files are converted.

NOTE: All subfiles described for the .fp file must be located in the same directory as the 
FP file. The files will not be converted unless all necessary files are complete.

NOTE: All files that are kept in the Input Folder are automatically converted as soon as 
the EFI Converter is launched.
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This chapter describes how to use the EFI Hot Folders application to store and reuse 
frequently used print options when printing PostScript and PDF files on the E-820. 
The Hot Folders application is a feature of the Fiery Graphic Arts Package.

Overview of Hot Folders
A Hot Folder is a special folder to which you can assign a group of print options. 
To print a document, you simply drag and drop the document file onto the 
Hot Folder. The Hot Folder application routes the job to a corresponding print queue 
with using the print options associated with that Hot Folder.

NOTE: After printing original data, you may notice additional numbers at the end of 
the original file name.

You can create as many Hot Folders as you want on your computer. You can also share 
Hot Folders with other users on the network by creating shortcuts to the folders from 
remote computers. 

To begin working with Hot Folders, create one or more Hot Folders, assigning print 
options and a print queue to each (see “Creating and deleting Hot Folders” on 
page 8-4). You can then print jobs by dragging and dropping the document files onto 
the corresponding Hot Folders. You can also print a job by printing the document file 
from the source application, with the appropriate Hot Folder specified as the print 
destination. The Hot Folder Control Panel allows you to manage your Hot Folders 
and monitor the status of jobs sent to the folders (see “Using the Hot Folder Control 
Panel” on page 8-2).
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File format restrictions
The Hot Folder application supports the printing of PostScript and PDF jobs. 
However, if you specify print options that differ from and override the printer default 
options, or specify imposition options, the E-820 may offer only restricted file format 
support. These restrictions vary, depending on the E-820 associated with the 
Hot Folder.

The E-820 offers full support for PostScript and PDF jobs if you assign only printer 
default options to a Hot Folder.

For information on setting print options, see Appendix A. 

NOTE: Hot Folders route PostScript jobs directly to the server, along with imposition 
information. The server converts PostScript to PDF before processing the imposition 
information. For imposition options, see page 8-12.

Using the Hot Folder Control Panel
The Hot Folder application continuously monitors the Hot Folders on your computer 
for new jobs. This activity occurs in the background; you do not have to start the 
Hot Folder application for the monitoring to occur. 

To display the Hot Folder Control Panel, start the Hot Folder application. 
The Hot Folder Control Panel allows you to create and manage all your folders. 
You can also use the Control Panel to monitor the status of jobs sent to your folders. 

File format Print option override Imposition

PostScript Fully supported Fully supported (with 
PS-to-PDF conversion)

PDF Partially supported Fully supported
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The Hot Folder Control Panel displays the name of each Hot Folder currently defined 
on your computer, the name of the server associated with each Hot Folder, and the 
directory path to the Hot Folder.

TO START THE HOT FOLDER APPLICATION AND DISPLAY 
THE CONTROL PANEL

• Click Start, choose Programs, and then choose Hot Folder or, if you have created a 
shortcut to the application, double-click the shortcut on your computer desktop.

You can also display the Hot Folder Control Panel by right-clicking the Hot Folder 
icon in the Status area of the Windows taskbar and choosing Open Control Panel 
from the menu that appears, or by opening the Windows system Control Panel and 
double-clicking the icon for EFI Hot Folders.
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Creating and deleting Hot Folders
Each Hot Folder you create resides on your hard disk and contains all the files and 
subfolders corresponding to information about your jobs. You can print jobs by 
dragging and dropping them onto this folder.

To delete a Hot Folder from your computer, you must disable and remove it from 
the Hot Folder Control Panel.

TO ADD AND CONFIGURE THE CONNECTION AND PRINT QUEUE 
FOR A  NEW HOT FOLDER

1. Click Add in the Hot Folder Control Panel. 

The Add folder dialog box appears.

2. Select an existing folder or navigate to the location where you want to create a new 
folder and enter the folder name. 

3. Click OK.

The Folder Properties dialog box for the Hot Folder will appear.
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NOTE: Do not use the following folder types as Hot Folders:

• The System Folder of your computer

• The Desktop Folder of your computer

• Folders located on a root directory (for example, c:\)

• Folders located on network drives, such as a common file server (unless the 
Hot Folder application is installed and running locally on the file server).

4. In the Server field, click Select.

The Select Server dialog box appears.

5. To configure the connection to the E-820 server in a local subnet, click the 
AutoSearch tab. 

Only servers that support Hot Folders appear in the Available Servers area. 

To add a server from the local subnet, select it and click OK.
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To manually configure the connection to the E-820, click the Manual tab and enter the 
IP address or DNS name of the E-820 and click OK.

6. In the Logical Printer field, choose the print queue for the Hot Folder.

7. In the Properties dialog box, specify properties and settings for the new Hot Folder.

For more details on job and imposition settings, see “Customizing Hot Folder settings” 
on page 8-9.

8. Click OK.

The new Hot Folder is ready for use. The folder name appears in the list in the 
Hot Folder Control Panel.

NOTE: If the number of copies in the Hot Folder setting is set to one, the number of 
copies for a PostScript file is applied. If the number of copies in the Hot Folder setting 
is set to two or more, the Hot Folder setting is applied.

TO DELETE A HOT FOLDER FROM YOUR COMPUTER

1. In the Hot Folder Control Panel, select the folder you want to remove.

Make a note of the folder’s directory path.

2. If the folder is not already disabled, click Disable.

You must disable a folder before you can remove it.
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3. Click Remove.

The folder is removed from the Control Panel.

4. Click OK to close the Hot Folder Control Panel.

5. Locate the Hot Folder on your computer, and make sure the folder does not contain 
any archived jobs you want to retain.

For information about using the subfolders to store archived jobs, see “Customizing 
Hot Folder settings” on page 8-9.

6. Delete the folder by dragging it to the Recycle Bin or choosing Delete from the 
File menu.

Enabling and disabling Hot Folders
By default, the Hot Folder application continuously monitors all your folders for new 
jobs. You can choose to disable a folder to prevent it from being monitored. Any jobs 
you send to a disabled folder remain unrecognized by the Hot Folder application until 
you enable the folder again.

TO TOGGLE THE ACTIVITY STATE OF A FOLDER

• In the Hot Folder Control Panel, select the folder you want and click Enable or Disable.
or

• Right-click the Hot folder you want on the desktop. Choose EFI HotFolders >Disable 
HotFolder or EFI HotFolders >Enable HotFolder from the menu that appears.
or

• Right-click the Hot Folder you want and choose Properties from the menu that 
appears. Click the EFI Hot Folder tab and select Enable Hot Folder or Disable 
Hot Folder.

Enabled folders are marked with a green state in the Control Panel; disabled folders are 
marked with a red state.
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Setting Hot Folder preferences
You can specify several preference settings for the Hot Folder application, including 
the unit of measurement used for imposition settings, and the default folder location 
for temporary files and imposition templates.

TO SET PREFERENCES FOR THE HOT FOLDER APPLICATION 
ON YOUR COMPUTER

1. Click Preferences in the Hot Folders Control Panel.

The Preferences dialog box appears. 

2. To specify the default unit of measurement, choose an option from the Units menu.

The default unit of measurement is used for several imposition settings.

3. To specify a folder location for temporary files created by the Hot Folders application 
while processing jobs, click Browse, select the folder you want, and then click OK.

If you do not specify a location for temporary files, the Hot Folder application uses the 
system Temp folder by default.

4. To specify a folder location for imposition templates used by the Hot Folders 
application, click Browse, select the folder you want, and then click OK.

5. When you are finished setting preferences, click OK.
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Assigning properties to Hot Folders
You can use the Folder Properties dialog box to define the settings associated with each 
Hot Folder. You can specify the print options, imposition settings, server destination, 
and queue destination each Hot Folder uses for incoming jobs.

Use any of the following methods to display the Folder properties dialog box:

• Create a new folder using the Hot Folder Control Panel (see page 8-4); the Folder 
properties dialog box appears.

• In the Hot Folder Control Panel, select the folder you want to edit and 
click Properties.

• Right-click the Hot Folder you want, and choose EFI HotFolders > Properties from 
the menu that appears.

• Right-click the Hot Folder you want, and choose Properties from the menu that 
appears. Click the EFI Hot Folder tab, and then click Configure.

Customizing Hot Folder settings
By default, each Hot Folder you create contains the following subfolders:

Fail Folder—the default location for storing all jobs that fail to process successfully. 
Problems at the print device might cause a job to fail.

NOTE: The Fail folder is for jobs that the Hot Folder cannot transfer to the server 
successfully. The Hot Folder will not log the server error of the job if the job fails to 
print or RIP.
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Move Folder—the default location for storing archive copies of all jobs that have been 
successfully processed; also referred to as the Keep Original Folder in the Folder 
Settings dialog box.

The file name of the archived job in the Move Folder has additional numbers at the 
end of the original file name to prevent jobs with the same file name from being 
overwritten. The 18 digit number at the end of the original file name is the year, date, 
time, and process id. The process id will increase by one if the user drops in multiple 
files at the same time.

Work Folder—a private folder used by the Hot Folder while processing a print job.

You can instruct the Hot Folder application to store archive copies of job files in the 
Fail and Move folders. You can also specify alternative folder locations for archive files.

TO ARCHIVE HOT FOLDER JOB FILES

1. Click Advanced in the Hot Folder Properties dialog box.

The Folder Settings dialog box appears.

2. To specify a different folder location for storing failed jobs, click Browse, select the 
folder you want, and then click OK.

3. To archive successfully processed jobs in the default Move folder, select Keep Original. 
To specify a different folder location, click Browse, select the folder you want, and 
click OK.

If you clear the Keep Original option, jobs dragged and dropped onto a Hot Folder are 
deleted from the folder as they are printed. 

4. Click OK.
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Specifying Hot Folder print options
You can assign print options to your Hot Folder as you would to any print job. When 
you specify print options for a Hot Folder, the print options are assigned to all jobs 
sent through that Hot Folder. These print options override any default options that 
may be associated with the destination printer group. 

When setting options for a folder assigned to a print job, all options for every print 
device in the group appear, and some might conflict. For more information on print 
options, see Appendix A.

NOTE: The direct connection is not supported when setting options for a folder.

TO SET PRINT OPTIONS FOR A HOT FOLDER

1. To enable print settings, select Job Settings in the Properties dialog box. If necessary, 
click Define to display the Job Settings dialog box. 

Print options are organized into functional groups. You can expand each group by 
clicking the corresponding menu bar.

2. Specify print options by choosing the print option from the appropriate menu. 

3. Click OK to return to the Properties dialog box.
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Specifying imposition options
If you have the DocBuilder Pro option installed and enabled on the E-820, you can 
configure the Hot Folder application to apply prebuilt imposition templates to 
print jobs. 

If the settings you want are not provided in the Hot Folders application, you can 
create a more detailed template using DocBuilder Pro, and apply the template to the 
Hot Folder. For more information about using DocBuilder Pro, see the Job 
Management Guide.

NOTE: The Direct connection is not supported when setting imposition options for a 
folder.

TO SPECIFY IMPOSITION OPTIONS

1. In the Properties dialog box, select Imposition Settings to enable imposition options. 
If necessary, click Define to display the Imposition Settings dialog box.

Imposition settings are only available if you have DocBuilder Pro installed and enabled 
for the E-820.

2. To specify the paper size for a print job, choose an option from the Sheet Size menu.
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3. To use a prebuilt imposition template, select the Select Template option and choose a 
template from the menu. 

The Hot Folders application provides a number of default imposition templates. The 
destination server applies the template imposition settings to your document prior 
to printing. 

4. To specify custom imposition settings, select Custom. 

5. Click Sheet, Layout, or Finishing to expand the panel of corresponding settings. 

6. Click OK to return to the Properties dialog box.

NOTE: If print settings specified for a folder do not match imposition settings specified 
for a prebuilt imposition template, the imposition settings will override the print 
settings when printing a job from a folder using an imposition template. For example, 
a job will print on Letter when Letter is specified as Page Size for your choice of 
imposition template, even if A4 is specified for the folder from which the job is 
printing.

For detailed information on imposition settings, see the Job Management Guide.

Panel Setting Result

Sheet Creep 
Adjustment

Adjusts imageable area of page to compensate for the binder’s 
creep that results from folding multiple sheets in saddle or 
nested saddle bindings.

Orientation Changes layout of sheet to Portrait or Landscape format.

Duplex Specifies printing on both the front and back sides of a sheet.

Layout Rows and 
Columns

Specifies the number of rows and columns to use when 
reproducing the image on each sheet for gang-up printing.

Printer’s 
Marks

Adds marks to indicate where sheets should be cut 
and folded.

Horizontal 
Bleed and 
Vertical Bleed

Specifies bleed values in pixels for each page.

Finishing Binding Specifies binding method, binding edge, and number of 
pages in each saddle group.

Gang-up Specifies style to use for gang-up printing.
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Viewing Hot Folder Job Logs
You can view a log of all jobs that have been processed through a Hot Folder.

TO VIEW THE JOB LOG FOR A HOT FOLDER

1. In the Hot Folder Control Panel, select the folder for which you want to view 
the Job Log.

2. Click View Log.

The Folder Log dialog box appears.

The Folder Log dialog box displays the following information:

Time—Indicates the time the job was processed through the Hot Folder.

Source—Lists the file name of the printed job.

Server—Displays the name of the server receiving the print job.

Status—Indicates whether or not the job was printed successfully.

3. Click Refresh to update the Job Log.

The Job Log is not updated in real time. New jobs are logged, but not listed, while the 
Folder Log dialog box is displayed. 

4. To clear the Job Log, click Clear All.
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The E-820 user software includes a variety of tools that allow you to track and manage 
print jobs. Access to some tools is controlled by your site administrator, but other 
tools are available to all users. 

• Command WorkStation, Fiery WebSpooler, and Fiery Spooler all provide 
the capability to view and control the flow of print jobs to the E-820. If the 
administrator has set Administrator and Operator passwords in Setup, you 
must have one of these passwords to perform most Command WorkStation, 
Fiery WebSpooler, and Fiery Spooler functions. For information on these 
tools and the access privileges needed to use them, see the Job Management 
Guide.

• WebTools do not require any special access privileges. As long as the 
administrator has enabled Web Services in Setup and provided users with the 
IP address of the E-820, anyone can use them. 

• Fiery Link, a utility designed to give you up-to-date status on print jobs and 
connected E-820 servers, is also available to all users. 

Accessing Fiery WebTools
Fiery WebTools reside on the E-820’s hard disk drive, but can be accessed over the 
network from a variety of platforms. The E-820 has a home page that allows you to 
view server functions and manipulate jobs remotely. This chapter describes only the 
Status and WebLink WebTools. 

For information on Fiery WebSpooler, see the Job Management Guide. For information 
on the EFI Fiery WebInstaller, see the User Software Installation Guide. For information 
on WebSetup, see the Configuration Guide. For information about WebScan, see 
Chapter 6. For information about WebDownloader, see Chapter 4

TO ACCESS WEBTOOLS

1. Start your Internet browser. 

For information about supported platforms and browsers, see the User Software 
Installation Guide.

Chapter 9:
Tracking and 
Monitoring Jobs 
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2. Enter the IP address or the DNS name of the E-820.

For this information, contact the operator or administrator.

3. If a Log In dialog box appears, select Guest and click OK.

The Log In dialog box appears only if the administrator has set a password. 
Guest access is sufficient to use the Status and WebLink WebTools as described in 
this chapter.

4. When the E-820 home page appears, click to select one of the Fiery WebTools.

Move the cursor over the buttons to display information about the selections.

Checking E-820 status with Fiery WebStatus
You can use Fiery WebStatus to see what jobs are currently processing and printing. 
To access Fiery WebStatus, open the E-820 home page and click Status. The current 
RIP Status and Printer Status appear in the window. 

NOTE: Use Webtools with the recommended resolution. For more information, see the 
System Requirements in the Quick Start Guide.
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To open a new browser window for the Status display, click Float. You can then close 
other browser windows and leave the Status window open to continue checking the 
status of the E-820. As long as you keep the Status window open, it is dynamically 
updated.

To obtain more information about the status of jobs, use Fiery WebSpooler, Fiery 
Spooler, or Command WorkStation, as described in the Job Management Guide. 
You can also use Fiery Link, as described on page 9-3.

Accessing information with WebLink
WebLink on the E-820 home page provides a link to another web page or to multiple 
web pages, provided you have a valid Internet connection. The administrator at your 
site can set the WebLink destination. Check your E-820 WebLink for any information 
available there.

Fiery Link
Fiery Link is designed to provide you with up-to-date status on print jobs and 
connected servers. It tracks the status of your print jobs and alerts you to errors. 
For example, you can see how many print jobs are ahead of your job in the queue. 
Fiery Link also provides information about paper and toner levels. For example, 
you can check paper size and levels in all trays before sending a job.

NOTE: The information in the Fiery Link window is updated every 20-30 seconds. 
Double-click the Fiery Link window to see updated information immediately.

For information on installing and configuring Fiery Link and on supported 
networking protocols, see the User Software Installation Guide.

NOTE: The Windows and Mac OS versions of Fiery Link are fundamentally the same; 
differences are noted in this section. Where both windows or dialog boxes are 
illustrated, the Windows version comes first, followed by the Mac OS version.
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TO BEGIN USING FIERY LINK

1. Double-click the Fiery Link icon, or choose Fiery Link from the Start> Programs menu.

The main Fiery Link window appears.

NOTE: To exit Fiery Link, press the Alt and F4 keys (Windows) or the Command and 
Q keys (Mac OS).

2. Click the currently selected server or print job to display the list of all connected 
servers or print jobs.

3. From this list, select the E-820 or the job about which you want information.

Displays the selected server or print job

lick to set preferences

Displays the selected 
Fiery Link tool

Click to scroll through the list 
of Fiery Link tools

Click to scroll through the list
of servers and print jobs

Click to edit My Fiery List

Click to minimize Fiery Link to 
the Tool Tray on the Taskbar 
(Windows only)
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4. Click the currently selected Fiery Link tool to display a list of all the tools (shown 
below), and select a tool.

Fiery Link tools
Fiery Link includes the following tools you can use to monitor a print job or a 
connected E-820. You can click the Up and Down arrows to scroll through the Tool 
List and open each tool in turn in the Fiery Link window.

Icon Tool If a print job is selected If a server is selected

Status Displays the job status and number of pages 
processed.

Displays the status of the server, including 
any error messages. You can make an error 
message disappear by clicking the Fiery Link 
window.

Queue Position Displays the number of jobs ahead of the 
selected job in the queue.

Displays the total number of active jobs 
queued to print on the server.

File Info Lists the file name, when it was sent to the 
server, the target server, the number of pages, 
and number of copies.

Lists the server name and connected device, 
total number of queued jobs, and the 
number of those jobs sent by the user.

Input Trays
(see below)

Displays the paper levels in all trays of the 
output device to which the job was printed.

Displays paper levels in all trays of the output 
device to which the server is connected.

Toner
(see below)

Displays the toner levels of the output device 
to which the job was printed.

Shows the toner levels of the output device to 
which the server is connected.
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Input Trays

Icons represent the paper level in each tray. A red icon indicates the paper tray is empty, 
a yellow icon indicates the paper tray is less than half full, and a green icon indicates 
the paper tray is more than half full. Up and Down arrows allow you to scroll through 
the available paper trays. 

Toner 

You can see how much toner your copier has by clicking the Toner tool. A warning 
appears if the copier is getting low on toner.

Preferences
Click the Preferences check box in the main window to view the Preferences 
dialog box.

Fiery Info Lists the model name, amount of memory, 
processor, and software version of the target 
server.

Lists the model name, amount of memory, 
processor, and software version of the server.

Support Displays the contact names and information 
for the target server and the output device.

Displays the contact names and information 
for the server and the output device.

Icon Tool If a print job is selected If a server is selected
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Setting the My Fiery List Options preferences

You can track print jobs, monitor E-820 servers, or both. If you select Track my print 
jobs and click the currently selected print job, the Active Job List window appears. 

If you select Monitor my Fierys and click the currently selected E-820 server, the 
Device List appears.

If you select Both and click the currently selected print job or E-820 server, both the 
Active Job List and Device List appear. 
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Setting the General and Alert option preferences

You can set the following options for tracking print jobs, monitoring servers, or both:

• Show/hide tool tips

• Show/hide animations

• Enable/disable stack alerts

• Enable/disable processing error notification

• Enable/disable printing error notification

• Enable/disable file printed notification

• Enable/disable consumable warnings notification

• Enable/disable Printer Report

My Fiery List
Select the Fiery check box ( ) in the main window to access the My Fiery List. 
You can use My Fiery List to specify the E-820 servers you want to monitor using 
Fiery Link. For information on setting up and changing the My Fiery List, see the 
User Software Installation Guide.

Windows taskbar menu
You can access a menu from the Windows taskbar status area to obtain information 
about Fiery Link, set some Fiery Link options, or exit the application.

TO ACCESS AND USE THE TASKBAR MENU

1. Right-click the Fiery Link icon ( ) in the Windows taskbar status area.

2. Choose one of the options from the menu.

Options with check marks are enabled.
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3. Choose About Fiery Link for version information.

4. Choose Always on Top to enable or disable the option.

If this option is enabled, the Fiery Link window always appears on top of other open 
windows. If this option is disabled, the Fiery Link window may be hidden by other 
open windows.

NOTE: The default setting for Fiery Link is to have Always on Top enabled.

5. Choose Dock Fiery Link to enable or disable the option.

If this option is enabled, the Fiery Link window is automatically repositioned to either 
the far left or the far right of your screen. If this option is disabled, you can position the 
Fiery Link window anywhere on the screen.

6. Choose Exit to exit Fiery Link.
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The Fiery E-mail Service allows you to remotely print to and control the E-820 
using your current e-mail infrastructure. It allows you to print to remote locations 
and bypass firewalls. With E-mail Service, you can submit jobs to the E-820 as 
e-mail attachments. 

You can use E-mail Service in the following ways: 

• Print using an E-mail Client

• Print using the E-820 E-Mail Port Monitor

• Scan using Scan to E-mail

How Fiery E-mail Service works
In order to use the e-mail services, you must set up E-mail Service as described in
the Configuration Guide.

To print with an E-mail Client, you send a file as an e-mail attachment, and E-mail 
Service extracts the file and sends it to the E-820. The e-mail attachment must be a PS 
or PDF file.

To print using the Fiery E-mail Port Monitor, you must print to a printer connected to 
the Fiery E-mail Port Monitor. If you have the E-mail Port Monitor set up, your print 
job is e-mailed to the E-820 when you choose Print from an application. For more 
information about setting up the E-mail Port Monitor, see the User Software 
Installation Guide.

Fiery E-mail Service also supports Scan to E-mail, a feature that allows you to scan 
a document and send it to an e-mail address as an attachment or URL. For more 
information about Scan to E-mail, see Chapter 6.

Chapter 10:
Using Fiery 
E-mail Service
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The E-820 also supports internal address books. Administrators can retrieve, add, 
delete, and clear addresses from the address books by sending requests via e-mail. 
For more information about address books, see the Configuration Guide.

NOTE: Fiery E-Mail Service will not process .vbs, .exe, or .bat extensions.

Printing using an E-mail Client
You can submit print jobs to the E-820 in the form of an e-mail attachment using your 
e-mail application. When you send an e-mail with an attachment, E-mail Service 
extracts the file and sends it to the E-820 Print queue. The file format must be one 
supported by the E-820. 

By default, anyone can print with an E-mail Client, unless the Print address book has 
been set up by the Administrator. If your e-mail address is not in the Print address 
book, you cannot send files to the E-820 via e-mail. For more information about 
address books, see the Configuration Guide. 

NOTE: The Direct and Hold queues are not supported when using the E-mail Client 
feature.

NOTE: The following illustrations depict the Microsoft Outlook E-mail application. 

TO PRINT USING AN E-MAIL CLIENT

1. Open your e-mail application.

2. Enter the E-820 e-mail address in the To: line.

3. Enter text in the Subject line or leave the Subject line blank.
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4. Attach the file you want to print in the body of the e-mail. 

You can enter a additional text in the body of the message, if necessary. The text will 
also be printed.

NOTE: If your attachment exceeds the file size limitation set by your e-mail system 
administrator, the e-mail will not be sent. 

5. Send the e-mail.

The file is sent to the E-820 and the job is printed. After the E-820 receives the job, 
you will receive an e-mail notification that the print job was accepted. The e-mail also 
provides a job identification (ID). You can use the job IDs to manage jobs with Job 
Control (see the following section). The e-mail notification indicates any current error 
at the copier. 

Once the job has been printed, you will receive a second e-mail notification that 
indicates the job printed successfully. 

To check the status of your job, you can use Job Control to see if the job printed out 
successfully. 
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Job Control
You can manage personal jobs when printing by submitting commands to the E-820 
via e-mail. You can cancel a job, check job status, and inquire help on a job. Once you 
send a command, the E-820 returns an e-mail response. 

TO MANAGE PRINT JOBS WITH JOB CONTROL

1. In your e-mail application, enter the E-820 e-mail address in the To: line.

2. Enter one of the following Job Control commands in the Subject line. 

To check the status of a job, enter #JobStatus<job id> in the Subject line.

You will receive a reply to your job status query. You can only inquire about the status 
of the job if you sent the job or are an administrator.

To cancel a job, enter #CancelJob<job id> in the Subject line. 

You will receive a notification indicating that the job has been cancelled and will not 
print to the E-820. You can only cancel the job if you sent the job or are an 
administrator.

To inquire help, enter #Help in the Subject line.

You will by sent an e-mail response that contains the links that allow you to cancel 
jobs, check job status, and search and manage address books. Click any of the links to 
perform a Job Control command.

Printing using the E-mail Port Monitor
Once you set up the E-mail Port Monitor, you can print using E-mail Service in the 
same manner as any other printing method. No additional steps are necessary.

NOTE: The E-mail Port Monitor is only supported on Windows OS.

NOTE: The Direct connection is not supported when printing with E-mail 
Port Monitor.
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TO PRINT USING THE FIERY E-MAIL PORT MONITOR

1. Choose Print in your application.

2. Make sure the E-820 is selected as your printer and you have set up the E-mail Port 
Monitor for the E-820.

3. Click Properties.

4. Click the Fiery Printing tab.

5. Set the print options and click OK.

To set options using the printer driver, see “Setting options and printing from 
Windows computers” on page 1-1.

Your job is sent to the E-820.

NOTE: If the attachment exceeds the file size limitation set in your application, the 
attachment may be broken into several messages. 
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Printing the E-mail Log
When the E-mail server is down, the data sent to the Client might not appear. You can 
print the E-mail Log to see the data sent to the Client using the E-820 Control Panel 
or Command WorkStation. For more information about printing information pages 
such as the E-mail log in Command WorkStation, see the Job Management Guide.

TO CHECK THE E-MAIL LOG USING THE E-820 CONTROL PANEL

1. Press the Menu button on the Control Panel to display the Functions menu. 

2. Choose Print Pages, and then choose E-mail Log.
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Print options give you access to the special features of your copier and E-820. Print 
options can be specified in several places—in E-820 Setup, or from the printing 
application, Fiery Downloader, ColorWise Pro Tools, Command WorkStation, 
Fiery WebSpooler, or Fiery Spooler. The table in this appendix briefly describes each 
print option, gives its default setting, and provides information on any constraints or 
requirements in effect.

About printer drivers and printer description files
The E-820 receives files from computers on the network, processes (RIPs) them, and 
then sends them to the copier. Windows and Mac OS computers communicate with 
the E-820 by means of a printer driver and printer description (PPD) files. The driver 
allows you to use special features of the E-820 from the Print dialog box. 

A printer driver manages printing communication between your application and the 
printer. It interprets the instructions generated by the application, merges those 
instructions with printer-specific options you specify, and translates all information 
into PostScript, a language the printer understands. In other words, the printer driver 
writes a PostScript file based on your original file and the options you set from the 
Print dialog box.

A printer driver also allows you to select print options for your copier. To do this, the 
printer driver must be matched with a PPD file for your E-820. A PPD file contains 
information about the features and capabilities of a particular device (for example, 
what paper sizes and media types are supported). The printer driver reads the 
information in this file and presents that information to you in the form of options 
you can choose from the Print dialog box. 

For information on the specific print options for the E-820, see the table on page A-2.

Appendix A: 
Print Options
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Where to set print options
• During Setup

Some settings are specified during Setup by the administrator. For information on 
the current default server settings, contact the administrator or the operator.

• From applications

With the Adobe PostScript printer drivers, you can specify job settings when you 
print a job. For information about specifying job settings from applications, 
see Chapter 1 and Chapter 2.

• From Fiery Downloader

Only a few settings—Copies, Page Range (for PDF files only), and Brightness (for 
PostScript and EPS files only)—can be specified when printing jobs with Fiery 
Downloader. To change options in Fiery Downloader, select a job in the Files to be 
Downloaded (Windows) or Files to Download (Mac OS) list and click Options. 
For more information, see Chapter 4.

• From ColorWise Pro Tools

You can set the default CMYK Simulation Profile, CMYK Simulation Method, 
RGB Source Profile, RGB Separation, Output Profile, Rendering Style, Spot Color 
Matching, Pure Black Text/Graphics, and Black Overprint settings. For more 
information on using ColorWise Pro Tools, see the Color Guide.

• Overrides from Command WorkStation, Fiery WebSpooler, and Fiery Spooler

To change job settings from Command WorkStation, double-click a job to display 
the Properties dialog box. To change job settings from Fiery WebSpooler and Fiery 
Spooler, double-click a job to display the Override Print Settings dialog box. 
For more information, see the Job Management Guide.

Print option override hierarchy
The override hierarchy is as follows: 

• A user’s printer driver settings override the E-820 Setup and ColorWise Pro Tools 
settings.

• Settings made from Command WorkStation, Fiery WebSpooler, or Fiery Spooler 
override the user’s printer driver settings.
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Default settings
In the following table, underlined settings in the Option and settings column indicate 
default printer driver settings (PPD defaults). If you do not use the printer driver 
interface to configure a particular option, the E-820 prints the job with the underlined 
setting.

For options that can be configured in Setup from the Control Panel, Command 
WorkStation, WebSetup, or ColorWise Pro Tools, choosing Printer’s default results in 
the E-820 printing the job with the Setup setting specified. For options that cannot be 
configured in Setup, the E-820 prints the job with a pre-configured Printer’s default 
setting. For more information, see the Requirements, constraints, and information 
column.

To determine the current Setup defaults, print the Configuration page from 
Command WorkStation or the E-820 Control Panel.

Option and settings 
(default setting is underlined)

Description
Requirements, constraints, 

and information

Auto Trapping
Printer’s default /Off/On

Specify whether the job should 
automatically trap text and graphics 
independently of their application.

This option is available as part of the 
Fiery Graphic Arts Package
.

Black Overprint
Printer’s default/Off/On

Select Off to print black text with 
knockouts.
Select On to overprint black text.

The Printer’s default setting reflects the 
setting specified in E-820 Setup.
For Windows, choose Expert Color as the 
Color Mode to access this option.
If this option is set to On, the Combine 
Separations option must be set to Off.
Setting this option to On automatically 
sets the Pure Black Text/Graphics option 
to On. For more information, see the 
Color Guide.

Brightness
Printer’s default/85% 
Lightest/90% Lighter/95% Light/
100% Normal/105% Dark/ 
110% Darker/115% Darkest

Select 85% for a substantially lighter 
image, 115% for a substantially darker 
image, or use one of the settings in 
between.

The Printer’s default setting reflects the 
setting specified in E-820 Setup.
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CMYK Simulation Method
Printer’s default/Quick/Full (Source 
GCR)/ Full (Output GCR)

Select Quick to use one-dimensional 
transfer curves to adjust density output 
of individual color channels.
Select Full (Source GCR) for a more 
complete and accurate simulation by 
applying colorimetric transformations 
that adjust hue as well as output density. 
This option produces output that 
maintains the same amount of black as 
the source document. 
Select Full (Output GCR) to apply the 
same simulation method as Full (Source 
GCR), except that the output produced 
contains a black amount determined by 
the output profile.

The Printer’s default setting reflects the 
setting specified in E-820 Setup.
For Windows, choose Expert Color as 
the Color Mode to access this option.
For more information, see the
Color Guide.

CMYK Simulation Profile
Printer’s default/SWOP-Coated/
DIC/Euroscale/Simulation-1/
Simulation-2/Simulation-3/
Simulation-4/Simulation-5/
Simulation-6/Simulation-7/
Simulation-8/Simulation-9/
Simulation-10/None/Match Copy

Specify the simulation goal to be used for 
the current print job.

The Printer’s default setting reflects the 
setting specified in E-820 Setup.
For Windows 9x/Me and Windows NT 
4.0, choose Expert Color as the Color 
Mode to access this option.
For more information, see the Color 
Guide.

Color Mode
CMYK/Grayscale
(from the Mac OS driver)
OR
Print Mode
Standard Color/Expert Color/Grayscale
(from the Windows drivers)

Specify the color mode for the current 
print job.
Select CMYK, Standard Color, or Expert 
Color for a full-color document.
Select Grayscale for a grayscale or black-
and-white document.

The Printer’s default setting reflects the 
setting specified in E-820 Setup.
The options differ depending on which 
driver you use.
For Windows, you must choose Expert 
Color to set other color print options, 
including Pure Black Text/Graphics.

Combine Separations
Off/On

When printing separations from a 
desktop publishing application:
Select On to combine separations on a 
single page.
Select Off to view separations as four 
individual black-and-white pages, 
each representing one color plate.

For more information, see the
Color Guide.

Option and settings 
(default setting is underlined)

Description
Requirements, constraints, 

and information
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Copies
1-999

Specify the number of copies of the job to 
print.

Do not enter a value greater than 999.

Create Master
None/1-15

To create a FreeForm master from this 
job, specify a number to assign to the 
FreeForm master file.

For more information, see page 5-2.
Command WorkStation allows you to 
select up to 100 FreeForm Masters.

Dithering
Auto/Text/Photos

Select Letter if the file contains detailed 
drawings and small text.
Select Photo if the file is a photograph.
Select Auto if the file is a combination of 
text and photographs.

Duplex
Off/Side Binding/Top Binding

Select Off for simplex (single-sided) 
printing.
Select Side Binding for duplex (double-
sided) printing with both sides using the 
same top edge.
Select Top Binding for duplex printing 
with the back side upside down

For more information on duplex 
printing, see page A-11.

Group Name If Printing Groups is enabled, the E-820 
Administrator has assigned users to print 
groups, and passwords to each group. 
Enter the appropriate Group
Name for the print job.

Group Password If Printing Groups is enabled, the E-820 
Administrator has assigned users to print 
groups, and passwords to each group. 
Enter the appropriate Group Password 
for the print job.

Halftone Screen
Printer’s default/Contone/Newsprint/
Application Defined/User Defined 
Screen1/User Defined Screen 2/User 
Defined Screen 3

Specify the screening method for your 
print job.

This option is available as part of the 
Fiery Graphic Arts Package.

Halftone definition is set in E-820 Setup. 
For more information, see the 
Configuration Guide.

Option and settings 
(default setting is underlined)

Description
Requirements, constraints, 

and information



AA-6 Print Options
Image Smoothing
Printer’s default/Off/On/Below 90 
ppi/Below 150 ppi/Below 200 
ppi/Below 300 ppi

Select On to minimize grainy output 
when printing low-resolution images.

This option is effective only for images 
having a resolution of 100 pixels per inch 
(ppi) or below.
If you create an EPS file in Photoshop, 
the settings specified from PhotoShop 
will take effect.

Instructions Enter instructions for the operator about 
the job.

Landscape
Yes/No

Specify if you will be printing on 
landscape-oriented paper.

This option is only available from 
Windows 2000/XP and Mac OS. For 
Windows 9x/Me and Windows NT 4.0, 
use the Orientation option. 

Media Type 
Plain Paper/Transparency/Thick 
Paper/Extra Thick Paper

Specify the media type to use for the 
entire job.

Select Transparency if you will be 
printing on transparencies. The 
Transparency setting is only supported 
with the Manual Feed tray.

Notes Enter information about the job. The Notes 1 field has a 32-character 
limit.

Orientation
Portrait/Landscape

Specify the orientation of the document.
Select Landscape to rotate the pages of a 
landscape-oriented job 180 degrees.

(Other) Gamma
Printer’s default/1.0/1.2/1.4/1.6/
1.8/2.0/2.2/2.4/2.6/2.8/3.0

Specify a source gamma value for 
printing RGB images, objects, and text.

Setting this option to Printer’s default 
produces the same result as the 
2.2 setting.
For more information, see the
Color Guide.

(Other) Phosphors
Printer’s default/Hitachi EBU/
Hitachi-Ikegami/NTSC/
Radius Pivot/SMPTE/Trinitron

Specify a source phosphors value for 
printing RGB images, objects, and text.

The Printer’s default setting produces the 
same result as the SMPTE setting. 
For more information, see the 
Color Guide

Option and settings 
(default setting is underlined)

Description
Requirements, constraints, 

and information



AA-7 Print Options
(Other) White Point
Printer’s default/5000 K (D50)/
5500 K/6500 K (D65)/7500 K/9300 K

Specify a source white point value for 
printing RGB images, objects, and text.

The Printer’s default setting produces the 
same result as the 5000K setting. 
For more information, see the 
Color Guide.

Optimize PowerPoint
Printer’s default/Off/On

Select On when printing PowerPoint files 
to the E-820.

Selecting On can reduce the processing 
time for PowerPoint print jobs. 

NOTE: Selecting On may only provide 
subtle differences in processing time.

Output Profile
Printer’s default/Output-1/Output-2/
Output-3/Output-4/Output-5/
Output-6/Output-7/Output-8/
Output-9/Output-10

Specify the output profile to use for the 
current print job.

The Printer’s default setting reflects the 
setting specified in ColorWise Pro Tools.
For Windows, choose Expert Color as 
the Color Mode to access this option.
For more information, see the
Color Guide.

Page Order
Printer’s default/Forward/Reverse

Select Forward to print the pages of your 
job from first to last.
Select Reverse to print the pages of your 
job from last to first.

The Printer’s default setting reflects the 
setting specified in E-820 Setup.

NOTE: If you set Page Order to Reverse 
and print a job with more than 1000 
pages, or a job that is too large to be saved 
to the E-820’s memory and disk (based 
on currently available space), then the job 
might print in sections that have to be 
manually rearranged after printing.
For example, if you print a 1500-page 
document in reverse order, the E-820 
might divide the job into two portions, 
first printing pages 1000 to page 1, and 
then pages 1500 to page 1001.

Option and settings 
(default setting is underlined)

Description
Requirements, constraints, 

and information



AA-8 Print Options
Page Size
Letter/ A4/Legal/11x17/A3/A5/A5 
SEF/A6 SEF/Legal 13/Letter SEF/A4 
SEF/B4/B5/B5 SEF/B6 SEF/Postcard 
(100x148mm)/Double 
Postcard/12x18/13x19/8.5x5.5/
PostScript Custom Page 
Size/Statement/Tabloid

Specify the size of the paper on which to 
print the document.

Paper Simulation
No/ Yes

Specify if you want to adjust the color 
according to the shade of the paper stock 
used as printable CMYK values in the 
output color space.

This option is available as part of the 
Graphic Arts Package.
Selecting On with Copier Mode set to 
Auto 2 might conflict with the Paper 
Simulation setting.

Paper Source
AutoSelect/Tray 1/Tray 2/ Tray 3/ 
Manual Feed/Manual Duplex/LCT

Specify the paper tray to use for your job. The AutoSelect setting automatically 
selects the tray containing the paper size 
specified for the job.
If you select Manual Feed or Manual 
Duplex, you must load the appropriate 
paper in the Manual Feed tray and select 
the correct paper size for the print job. 
Otherwise a paper jam might occur.

Pure Black Text/Graphics
Printer’s default/Off/On

Select Off to print black text and graphics 
as a four-color black using C, M, Y, and 
K toner, and to use normal PostScript 
rendering.
Select On to print black text and graphics 
as a one-color black, using 100% black 
toner only.

The Printer’s default setting reflects the 
setting specified in E-820 Setup.
For Windows, choose Expert Color as the 
Print Mode to access this option.
This option is automatically set to On if 
the Black Overprint option is set to On.
For more information, see the Color 
Guide.

Remove White PPT Background
No/Yes

Select Yes when using PowerPoint to 
create variable data in conjunction with 
FreeForm.

This option is available from Command 
WorkStation, Fiery WebSpooler, or Fiery 
Spooler only.

Option and settings 
(default setting is underlined)

Description
Requirements, constraints, 

and information



AA-9 Print Options
Rendering Style
Printer’s default/Photographic/
Presentation/Relative Colorimetric/
Absolute Colorimetric

Specify a default color rendering 
dictionary (CRD) to use when you print 
RGB images, objects, and text.

The Printer’s default setting reflects 
the setting specified in E-820 Setup.
For Windows, choose Expert Color as 
the Color Mode to access this option.
For more information, see the 
Color Guide.

RGB Separation
Printer’s default/Output/Simulation

Select Output for RGB jobs you are 
printing to the final output device.
Select Simulation for RGB jobs for which 
you want to simulate an output device 
other than the device you are printing to.

The Printer’s default setting reflects the 
setting specified in E-820 Setup.
For Windows, choose Expert Color as 
the Color Mode to access this option.

RGB Source Profile
Printer’s default/EFIRGB/sRGB (PC)/
Apple Standard/Other/Source-1/
Source-2/Source-3/Source-4/Source-5/
Source-6/Source-7/Source-8/Source-9/
Source-10/None

Specify a source color space definition for 
printing RGB images, objects, and text.

The Printer’s default setting reflects the 
setting specified in E-820 Setup.
For Windows, choose Expert Color as 
the Color Mode to access this option.
For more information, see the
Color Guide.

Rotate 180
Yes/No

Specify if you want to rotate the pages of 
your job 180 degrees.

This option is only available from 
Mac OS and Windows 2000/XP. For 
Windows 9x/Me/NT, use the 
Orientation option.

Depending on the application you are 
using, your landscape job might print 
with the incorrect orientation; if this 
occurs, or if you select a Stapler Mode 
(other than Off ) and the staple is inserted 
in the wrong place, select Yes.

Save Fast Reprint
Off/On

Specify whether to save a job’s raster data 
to disk after printing, so the data will be 
available later for reprinting (without 
reRIPping).

With this option set to On, all print 
option settings remain with the saved 
raster data each time the job is reprinted. 
To print the job with new print option 
settings, you must remove the raster data 
and reRIP the job.

Option and settings 
(default setting is underlined)

Description
Requirements, constraints, 

and information



AA-10 Print Options
Scale
25-400%
100%

Specify a scaling override for your 
print job.

This option is available only as an 
override from Fiery WebSpooler, Fiery 
Spooler, and Command WorkStation.
For more information, see page A-12.

NOTE: This option is not the same as the 
Scale option available from the printer 
driver.

Slip Sheet
On/Off

Specify whether to insert a slip sheet 
between copies of multiple-copy jobs. 

To use this option, your Media Type 
must be set to Transparency and Paper 
Source must be set to Manual Feed.

Sorter Mode
Collate/ Sort/Stack/Off

Specify how to output 
multiple-page/multiple-copy jobs.

For information, see page A-12.

Spot Color Matching
Printer’s default/Off/On

Select Off to print specified PANTONE 
colors in your job using the current 
CMYK Simulation and CMYK 
Simulation Method.
Select On to activate the PANTONE 
Lookup Table. The E-820 prints specified 
PANTONE colors in your job by 
matching the CMYK print blend to the 
same color from the PANTONE library.

The Printer’s default setting reflects the 
setting specified in E-820 Setup.
For Windows, choose Expert Color as the 
Color Mode to access this option.
For more information, see the 
Color Guide.

Stapler Mode
Off/Top Left/Top Right/Two Centers

Specify how to staple 
multiple-page/multiple-copy jobs.

Tray Alignment
Printer’s default/Enable/Disable

Specify if you want to enable tray 
alignment.

If you enable, the Paper Source cannot be 
set to AutoSelect at the copier.
For more information, see the Job 
Management Guide.

Toner Reduction
On/Off/Printer’s default

Select On you want the Toner Reduction 
On to conserve the amount of toner used 
when printing a job.

For more information on Toner 
Reduction values, see page A-12 and the 
Color Guide.

Use Master
None/1-15

For variable data print jobs, specify a 
FreeForm master number to be used for 
the job.

For more information, see page 5-2.
Command Workstation allows you to 
select up to 100 FreeForm Masters.

Option and settings 
(default setting is underlined)

Description
Requirements, constraints, 

and information



AA-11 Print Options
More about print options
The following sections provide additional information about print options. For more 
information on the settings, requirements, and constraints in effect for these options, 
see the preceding table.

Duplex 

All duplex printing features are available only with plain paper media type.

TO PRINT DUPLEX PAGES

1. Choose Print in your application and locate the Duplex print option.

The location of E-820 print options varies, depending on the printer driver you 
are using.

2. Choose one of the Duplex settings:

Side Binding—Prints the top of the image on Side 1, on the same edge of the page as 
the top of the image on Side 2.

Top Binding—Prints the top of the image on Side 1, on the opposite edge of the page 
from the top of the image on Side 2.

NOTE: For a landscape-oriented job, set the Landscape print option to Yes.

The following table shows how the Duplex settings correspond to printed output:

Side Binding Top Binding

Portrait

Landscape

1 2 1

2

1 2 1

2



AA-12 Print Options
Media Type

The Media Type option allows you to select the type of media for loading into the 
selected tray. For more information on media types, see the copier documentation for 
paper specifications.

Paper Source

If you choose the Auto Select setting, the copier prints from any tray containing the 
paper size necessary for the job. This setting also allows the copier to automatically 
switch between trays, if the current tray becomes empty, while continuing to print. 

Scale

The operator can specify a scaling override from Fiery Spooler or Fiery WebSpooler, 
but the override is applied to any scaling value already set in the active job. For 
example, if a user sends a job with a scaling value of 50% and the operator specifies a 
Scale override of 200%, the job is printed at 100% of the original document size, that 
is, 50% of 200%.

Sorter Mode

Sorting is supported on color copiers with a sorter/stapler unit attached.

Off—Copies of a complete job are uncollated and output into the top tray.

Collate—Copies of a complete job are collated and output into the top tray.

Sort—Copies of a complete job are sorted and output into one of 20 bins, arranged in 
page order. 

NOTE: The sorter has 20 bins. If you send more than 20 sets of copies to the sorter, the 
excess sets of copies (copies 21 and up) will not print. In order to print more than 20 
sets of copies to the sorter, remove the paper from the output bins and resend the 
remaining copies of the job.

Stack—Copies of a complete job are output into one of 20 bins, with all copies of the 
same page grouped together in each separate bin.

Toner Reduction

The Toner Reduction option minimizes the amount of toner used when printing a job. 
When the Toner Reduction is set to On, the toner reduction level is set to 250%. 
When the Toner Reduction is set to Off, the Toner Reduction is set to 300%. For more 
information, see the Color Guide.



BB-1 Font List
This appendix lists the built-in printer fonts included with your E-820. 

PostScript printer fonts
The following table lists the 136 built-in PostScript printer fonts on the E-820. 
In addition to these fonts, two Adobe Multiple Master fonts are included and used for 
font substitution in PDF files.

NOTE: For Mac OS computers, install the corresponding screen fonts from the 
User Software CD. For instructions, see the User Software Installation Guide.

Adobe Type 1 fonts
The E-820 includes 126 Adobe Type 1 fonts:

• The Mac OS column lists the name as it appears on the Font menu on a Mac OS 
computer. For example, in most applications, to use “Bodoni-Bold,” choose Bodoni 
Bold from the Font menu.

• The Windows menu name is the name as it appears on the Font menu on a 
Windows computer. The style refers to the style that must be selected in the 
application to access the particular PostScript font. For example, to use “Bodoni-
Bold,” choose Bodoni from the Font menu and Bold from the Style menu.

PostScript name Mac OS menu name Windows menu 
name, style 

AlbertusMT-Light Albertus MT Lt Albertus MT Lt 

AlbertusMT Albertus MT Albertus MT 

AlbertusMT-Italic Albertus MT It Albertus MT, Italic 

AntiqueOlive-Roman Antique Olive Roman Antique Olive Roman

AntiqueOlive-Bold Antique Olive Bold Antique Olive Roman, Bold

AntiqueOlive-Italic Antique Olive Italic Antique Olive Roman, Italic

AntiqueOlive-Compact Antique Olive Compact Antique Olive Compact

Arial-BoldItalicMT Arial Bold Italic Arial, Bold Italic

Arial-BoldMT Arial Bold Arial, Bold

Arial-ItalicMT Arial Italic Arial, Italic

ArialMT Arial Arial

Appendix B: 
Font List



BB-2 Font List
AvantGarde-Book Avant Garde AvantGarde

AvantGarde-Demi Avant Garde Demi AvantGarde, Bold

AvantGarde-BookOblique Avant Garde BookOblique AvantGarde, Italic

AvantGarde-DemiOblique Avant Garde DemiOblique AvantGarde, Bold Italic

Bodoni Bodoni Bodoni

Bodoni-Bold Bodoni Bold Bodoni, Bold

Bodoni-Italic Bodoni Italic Bodoni, Italic

Bodoni-BoldItalic Bodoni BoldItalic Bodoni, Bold Italic

Bodoni-Poster Bodoni Poster Bodoni Poster

Bodoni-PosterCompressed Bodoni PosterCompressed Bodoni PosterCompressed 

Bookman-Light Bookman Bookman 

Bookman-Demi Bookman Demi Bookman, Bold 

Bookman-LightItalic Bookman LightItalic Bookman, Italic 

Bookman-DemiItalic Bookman DemiItalic Bookman, Bold Italic

Carta Carta Carta

Clarendon-Light Clarendon Light Clarendon Light 

Clarendon Clarendon Clarendon 

Clarendon-Bold Clarendon Bold Clarendon, Bold

CooperBlack Cooper Black Cooper Black 

CooperBlack-Italic Cooper Black Italic Cooper Black, Italic

Copperplate-ThirtyThreeBC Copperplate33bc Copperplate33bc

Copperplate-ThirtyTwoBC Copperplate32bc Copperplate32bc

Coronet Coronet Coronet

Courier Courier Courier 

Courier-Bold Courier Bold Courier, Bold 

Courier-Oblique Courier Oblique Courier, Italic 

Courier-BoldOblique Courier BoldOblique Courier, Bold Italic

Eurostile Eurostile Eurostile

Eurostile-Bold Eurostile Bold Eurostile Bold

Eurostile-ExtendedTwo Eurostile ExtendedTwo Eurostile ExtendedTwo

Eurostile-BoldExtendedTwo Eurostile BoldExtendedTwo Eurostile ExtendedTwo, Bold

PostScript name Mac OS menu name Windows menu 
name, style 



BB-3 Font List
GillSans GillSans GillSans 

GillSans-Bold GillSans Bold GillSans, Bold 

GillSans-Italic GillSans Italic GillSans, Italic 

GillSans-BoldItalic GillSans BoldItalic GillSans, Bold Italic 

GillSans-Light GillSans Light GillSans Light 

GillSans-LightItalic GillSans LightItalic GillSans Light, Italic

GillSans-Condensed GillSans Condensed GillSans Condensed 

GillSans-BoldCondensed GillSans BoldCondensed GillSans Condensed, Bold 

GillSans-ExtraBold GillSans ExtraBold GillSans ExtraBold 

Goudy Goudy Goudy 

Goudy-Bold Goudy Bold Goudy, Bold 

Goudy-Italic Goudy Italic Goudy, Italic 

Goudy-BoldItalic Goudy BoldItalic Goudy, Bold Italic

Goudy-ExtraBold Goudy ExtraBold Goudy ExtraBold

Helvetica Helvetica Helvetica 

Helvetica-Bold Helvetica Bold Helvetica, Bold 

Helvetica-Oblique Helvetica Oblique Helvetica, Italic 

Helvetica-BoldOblique Helvetica BoldOblique Helvetica, Bold Italic

Helvetica-Narrow Helvetica Narrow Helvetica-Narrow 

Helvetica-Narrow-Bold Helvetica Narrow Bold Helvetica-Narrow, Bold 

Helvetica-Narrow-Oblique Helvetica Narrow Oblique Helvetica-Narrow, Italic 

Helvetica-Narrow-
BoldOblique

Helvetica Narrow BoldObl Helvetica-Narrow, Bold Italic

Helvetica-Condensed Helvetica Condensed Helvetica Condensed 

Helvetica-Condensed-Bold Helvetica CondensedBold Helvetica Condensed, Bold 

Helvetica-Condensed-
Oblique 

Helvetica CondensedOblique Helvetica Condensed, Italic 

Helvetica-Condensed-
BoldObl 

Helvetica 
CondensedBoldObl 

Helvetica Condensed, Bold 
Italic

HoeflerText-Ornaments Hoefler Text Ornaments Hoefler Text Ornaments

JoannaMT Joanna MT Joanna MT 

JoannaMT-Bold Joanna MT Bd Joanna MT, Bold 

PostScript name Mac OS menu name Windows menu 
name, style 



BB-4 Font List
JoannaMT-Italic Joanna MT It Joanna MT, Italic

JoannaMT-BoldItalic Joanna MT Bd It Joanna MT, Bold Italic

LetterGothic Letter Gothic Letter Gothic 

LetterGothic-Bold Letter Gothic Bold Letter Gothic, Bold 

LetterGothic-Slanted Letter Gothic Slanted Letter Gothic, Italic 

LetterGothic-BoldSlanted Letter Gothic BoldSlanted Letter Gothic, Bold Italic

LubalinGraph-Book Lubalin Graph LubalinGraph 

LubalinGraph-Demi Lubalin Graph Demi LubalinGraph, Bold 

LubalinGraph-BookOblique Lubalin Graph BookOblique LubalinGraph, Italic 

LubalinGraph-DemiOblique Lubalin Graph DemiOblique LubalinGraph, Bold Italic 

Marigold Marigold Marigold

MonaLisa-Recut Mona Lisa Recut Mona Lisa Recut

NewCenturySchlbk-Roman New Century Schlbk NewCenturySchlbk 

NewCenturySchlbk-Bold New Century Schlbk Bold NewCenturySchlbk, Bold 

NewCenturySchlbk-Italic New Century Schlbk Italic NewCenturySchlbk, Italic 

NewCenturySchlbk-
BoldItalic

New Century Schlbk BoldIt NewCenturySchlbk, Bold 
Italic

Optima Optima Optima 

Optima-Bold Optima Bold Optima, Bold 

Optima-Italic Optima Italic Optima, Italic 

Optima-BoldItalic Optima BoldItalic Optima, Bold Italic

Oxford Oxford Oxford

Palatino-Roman Palatino Palatino 

Palatino-Bold Palatino Bold Palatino, Bold 

Palatino-Italic Palatino Italic Palatino, Italic 

Palatino-BoldItalic Palatino BoldItalic Palatino, Bold Italic

StempelGaramond-Roman StempelGaramond Roman StempelGaramond Roman 

StempelGaramond-Bold StempelGaramond Bold StempelGaramond Roman, 
Bold 

StempelGaramond-Italic StempelGaramond Italic StempelGaramond Roman, 
Italic 

StempelGaramond-BoldItalic StempelGaramond BoldItalic StempelGaramond Roman, 
Bold Italic

PostScript name Mac OS menu name Windows menu 
name, style 
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Symbol Symbol Symbol

Tekton Tekton Tekton

Times-Roman Times Times

Times-Bold Times Bold Times, Bold

Times-Italic Times Italic Times, Italic

Times-BoldItalic Times BoldItalic Times, Bold Italic

TimesNewRomanPS-
BoldMT

Times New Roman Bold Times New Roman, Bold

TimesNewRomanPS-
BoldItalicMT

Times New Roman Bold 
Italic

Times New Roman, Bold 
Italic

TimesNewRomanPS-
ItalicMT

Times New Roman Italic Times New Roman, Italic

TimesNewRomanPSMT Times New Roman Times New Roman

Univers-Extended Univers Extended Univers Extended 

Univers-BoldExt Univers BoldExt Univers Extended, Bold 

Univers-ExtendedObl Univers ExtendedObl Univers Extended, Italic 

Univers-BoldExtObl Univers BoldExtObl Univers Extended, Bold Italic 

Univers-Light Univers 45 Light Univers 45 Light 

Univers-Bold Univers 65 Bold Univers 45 Light, Bold 

Univers-LightOblique Univers 45 LightOblique Univers 45 Light, Italic 

Univers-BoldOblique Univers 65 BoldOblique Univers 45 Light, Bold Italic 

Univers Univers 55 Univers 55 

Univers-Oblique Univers 55 Oblique Univers 55, Italic 

Univers-CondensedBold Univers 67 CondensedBold Univers 47 CondensedLight, 
Bold 

Univers-
CondensedBoldOblique 

Univers 67 
CondensedBoldObl 

Univers 47 CondensedLight, 
Bold Italic 

Univers-Condensed Univers 57 Condensed Univers 57 Condensed 

Univers-CondensedOblique Univers 57 
CondensedOblique 

Univers 57 Condensed, Italic

ZapfChancery-MediumItalic Zapf Chancery ZapfChancery

ZapfDingbats Zapf Dingbats ZapfDingbats

PostScript name Mac OS menu name Windows menu 
name, style 
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TrueType fonts
The E-820 includes 10 TrueType fonts:

PostScript name Mac OS menu name Windows menu 
name, style

Apple-Chancery Apple Chancery Apple Chancery

Chicago Chicago Chicago

Geneva Geneva Geneva

HoeflerText-Black Hoefler Text Black Hoefler Text Black

HoeflerText-BlackItalic Hoefler Text Black Hoefler Text Black, Italic

HoeflerText-Italic Hoefler Text Hoefler Text, Italic

HoeflerText-Regular Hoefler Text Hoefler Text

Monaco Monaco Monaco

New York New York New York

Wingdings-Regular Wingdings Wingdings



CC-1 Troubleshooting
This appendix provides troubleshooting tips.

Maintaining optimal system performance
The E-820 does not require maintenance. Beyond the routine requirements of 
servicing and maintaining the copier and replenishing consumables, you can improve 
the overall performance of your system by doing the following:

• Check job ticket information carefully before printing. 

Print jobs with the same output and paper specifications together, to minimize 
paper changes. Also, print routine jobs while you prepare to print jobs with special 
instructions or special media.

• Reduce unnecessary server connections to Command WorkStation. 

If you use a second or third E-820 on an occasional basis, you can improve 
performance by logging off when those systems are not in use.

• Avoid printing with the E-820 “Disk full” warning. 

If you see this warning, delete jobs that are not likely to be reused. Avoid this 
condition by deleting old jobs on a regular basis. The date associated with a job 
is the original date it was sent.

Troubleshooting
This section provides some troubleshooting guidelines should a problem arise. If you 
are unable to resolve a problem after referring to this section, contact your site operator 
or administrator. Also, make sure there are no applications installed on the E-820, with 
the exception of the E-820 utilities from the User Software CD. Applications other 
than the E-820 utilities are not supported and can cause system problems.

Appendix C: 
Troubleshooting



CC-2 Troubleshooting
General printing problems

If this happens Try this

You cannot connect to 
the E-820.

• Make sure the E-820 is not being calibrated from the Control Panel.

If the E-820 is being calibrated from the Control Panel, you can select it in the 
Chooser, but you cannot connect to it. This ensures that only one person is calibrating 
the E-820 at any time and that print jobs do not use unexpected calibration.

You cannot select or view 
one of the queues.

• Request that your system administrator enable the queue in Setup.

You cannot connect to 
the E-820 from a Windows 
computer with Command 
WorkStation or the 
Fiery utilities.

• Make sure the connection is configured correctly.

For instructions, see the User Software Installation Guide.

Printing seems to take too 
long.

• Print to a queue instead of to the Direct connection.

When you print to a queue, the job is stored on the E-820 until it can be processed and 
printed; when you print to the Direct connection, the job cannot be sent to the E-820 
until the previous job is finished processing, so you must wait longer to use your 
computer.

One or more Media Type 
options are dimmed.

• Select a Paper Source that supports the Media Type you are using. 

For information on requirements and constraints pertaining to special papers and 
transparencies, see Appendix A.



CC-3 Troubleshooting
The E-820 does not respond 
to a Print command.

• Make sure the copier was not disconnected.

If the administrator or operator has selected Suspend Printing on the E-820 Control 
Panel or Command WorkStation to interrupt printing, your print job will not resume 
until someone selects Resume Printing from the Functions menu on the Control Panel 
or clicks the function key on Command WorkStation.

• Make sure the E-820 is selected as the current copier.

Before printing, you must select the E-820 as the current printer from your Windows 
computer, Mac OS computer, or UNIX workstation.

• Make sure the copier is switched on.

Someone may have turned the copier off, or the Power Saver mode function may have 
engaged. Even with the copier off, the E-820 appears in the Chooser as long as the 
E-820 itself is turned on. 

• If you are printing over an IPX (Novell) network, verify through the PCONSOLE utility 
that the job was sent to the Novell queue and that the queue is being used by the 
E-820.

• Make sure the job does not contain a PostScript error.

Contact the operator, or use Fiery WebSpooler or Fiery Spooler to check job status. 
In Fiery WebSpooler or Fiery Spooler, a job containing a PostScript error appears 
in red. 

To obtain information on the PostScript error, make sure the Print to PS Error option 
is set to Yes in E-820 Setup. For more information, see the Configuration Guide.

You cannot print with 
QuarkXPress 3.32 using the 
PSPrinter 8.7.2 driver on a 
Mac OS computer.

• Remove the file called Balloon Help from your QuarkXPress application folder and 
restart QuarkXPress.

If this happens Try this



CC-4 Troubleshooting
Problems with print quality
For information about printing with specific applications and optimizing color output, 
see the Color Guide. 

If this happens Try this

Print settings for your job 
output do not match the 
settings you gave.

• Make sure you did not override the settings for the job in another place.

For information about options and overrides, see Appendix A.

You get poor printing results. • Check if your application requires one of the E-820’s printer description files.

Your application may require the E-820 PPD. If you print from Adobe PageMaker, 
make sure the E-820 PPD is installed correctly. For information about installing this 
file, see the User Software Installation Guide.

• Make sure the system has been calibrated.

For instructions, see the Color Guide.

The registration or colors of 
an image are not what you 
expected.

• Ask the operator to print a Test Page with the copier.

The problem may be with the copier. If your Test Page shows that the copier is working 
properly, correct the problem within your application. If the Test Page is wrong, your 
copier may need to be adjusted. 

Your printed file appears 
too dark.

• Adjust the Brightness option.

You can use the Brightness option when printing from an application or from Fiery 
Downloader to lighten your image whenever you print a PostScript or Encapsulated 
PostScript (EPS) file. 

Color file prints in black and 
white.

• In the Color Matching dialog box, make sure that Color/Grayscale, or ColorSync Color 
Matching or PostScript Color Matching is selected (not Black and White).

• Make sure the Color Mode print option is set to an option other than Grayscale.

Desktop Color Separations 
(DCS) format images print 
incorrectly.

• Make sure you selected the correct options to send separations in the application’s Print 
dialog box.

• Make sure you have the file for every layer of separation that you are printing.

• Set the Combine Separations option to On.

This combines the high-resolution files for an image and prints them. With Combine 
Separations Off, the low-resolution master file will print.

QuickDraw fill patterns print 
as solids.

• Use the Adobe PostScript Printer driver (or the Apple LaserWriter 8.3 or later printer 
driver).



CC-5 Troubleshooting
Problems with Fiery Downloader

If this happens Try this

General problems. • Make sure you are using the latest version.

If you are updating your E-820 to new system software, delete the previous version of 
Fiery Downloader from your Windows or Mac OS computer and install the latest 
version to ensure full compatibility.

• Make sure the connection is configured correctly.

For instructions, see the User Software Installation Guide.

You cannot print an EPS file 
using Fiery Downloader.

• Try printing using the ‘showpage’ after EPS files (Windows) or ‘showpage’ (Mac OS) 
option in the Download PostScript File dialog box.

This option adds a showpage PostScript language command at the end of the print job. 
Certain applications omit this necessary command when they generate EPS files. You 
must select the Append Showpage option when printing EPS files generated by these 
applications.

If you continue having difficulties printing an EPS file with Fiery Downloader, try 
printing the file from the application in which it was created.

• Make sure the EPS file was saved without a preview image header.

Preview image headers are useful when images are placed in documents with page 
layout applications, but they cause problems when images are downloaded directly.

• Make sure the job does not contain a PostScript error.

Contact the operator or use Command WorkStation, Fiery WebSpooler, or Fiery 
Spooler to check the job’s status. Jobs with a PostScript error appear with an Error icon.

You have problems 
downloading a font with 
Fiery Downloader.

• Check with the administrator to make sure that the Direct connection is enabled.

The Direct connection must be used to download fonts.

An extra blank page prints 
after a Fiery Downloader job.

• Turn off the ‘showpage’ after EPS files (Windows) or ‘showpage’ (Mac OS) option.

This option adds a special PostScript command that will cause an extra blank page to 
print if it is not necessary.



CC-6 Troubleshooting
Problems with Fiery Scan

Problems with Fiery WebTools

If this happens: Try this

Fiery Scan main window does 
not appear after launching.

• Check to see if the TWAIN module(s) installed by Photoshop are located in the correct 
folder. If not, reinstall Photoshop software.

If this happens Try this

General problems. • Clear the cache (Netscape Communicator) or history (Microsoft Internet Explorer).
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A
Active Job List 9-7
Adobe Photoshop

scanning with 6-1
transfer functions 4-7

Adobe Type 1 fonts B-1
Always on Top 9-9
archiving jobs

in Hot Folders 8-10

B
Black Overprint option A-3
Brightness option A-2, A-3
BSD 3-2

C
Calibrated RGB option 6-23
canceling scanning 6-23
CMYK Simulation Method option A-4
CMYK Simulation Profile option A-4
Color Conversion option in Fiery Scan 6-23
Color Mode option A-4
ColorWise Pro Tools

job overrides A-2
Combine Separations option A-4
Command WorkStation

managing print jobs 9-1
overriding FreeForm Master number 5-4
overriding Printer Setup settings 1-5

Create Master option 5-2
Custom Page Sizes

defining for Windows 2000/XP 1-18
defining for Windows NT 

4.0 1-11, 1-15, 1-18
Custom Paper Sizes

defining for Mac OS 2-7

D
DCS (Desktop Color Separations) C-4
Device List 9-7
Direct connection

downloading fonts 4-8
not in Chooser, Mac OS 2-2
required to download fonts C-5

Dock Fiery Link 9-9
Duplex option A-5, A-11

E
EFIRGB ICC file 6-1, 6-19
EFIRGB.icm file 6-1, 6-19
EPS (Encapsulated PostScript) files

downloading 4-1
downloading from Windows 1-1
problems downloading C-5

F
Fiery Downloader

Brightness option 4-7
choosing a printer 4-4
Connection Type 4-6
Download Progress bar 4-2, 4-3
downloading file or font 4-4 to 4-8
Hard Disk area 4-2, 4-3
installing printer fonts 4-9
job overrides A-2
PDF files 1-1
Print Status area 4-2, 4-3
problems with C-5
Queue 4-6
RIP Status area 4-2, 4-3
Toolbar 4-3
using 4-1



I-2 Index
Fiery Link
Active Job List 9-7
Always on Top 9-9
Device List 9-7
Dock Fiery Link 9-9
File Info tool 9-5
Input Trays tool 9-5, 9-6
My Fiery List 9-4, 9-8
preferences 9-4, 9-6
Queue Position tool 9-5
selecting a print job 9-4
selecting a server 9-4
Status tool 9-5
Support tool 9-6
Toner tool 9-5, 9-6

Fiery Scan
problems with C-6

Fiery WebTools
accessing 9-1
home page 9-2
overview 9-3
problems with C-6
WebLink 9-3

Fiery Email Service
about 10-1
Job Control 10-4
managing print jobs 10-4
printing using an E-mail client 10-2
printing using the E-mail Port 

Monitor 10-4
Fiery VDP Resource Manager

global objects 5-12
using 5-12

File Info tool 9-5
File name entry field 4-6
File port, saving files to 1-21
Files of type menu (Windows) 4-6
font list

Adobe Type 1 B-1
displaying 4-3, 4-10

PostScript B-1 to B-5
printing 4-3, 4-10
TrueType B-6

Font List button 4-3
fonts

Adobe Type 1 4-9, B-1
downloading and managing 4-1, 4-6
installing 4-9
PostScript 4-9
printer fonts 4-9
printer fonts on server 4-10
screen fonts 4-9
substitution with PDF files 4-10
TrueType B-6

FreeForm
Master number 5-4

FreeForm 2
printing variable data documents 5-10

G
Gamma option A-6
global objects

deleting 5-12
viewing 5-12

H
Hold queue 2-2
Hot Folders

about 8-1
adding 8-4
archiving job files 8-10
control panel, displaying 8-3
creating 8-4
deleting 8-6
disabling 8-7
enabling 8-7
imposition settings 8-12
preferences 8-8
print options for 8-11
properties, assigning 8-9 to 8-13
using 8-12



I-3 Index
I
impositions

applied through Hot Folders 8-12
Input Trays tool 9-5, 9-6
installing printer fonts 4-9
Instructions field 1-5

J
job

archiving 8-10
job log

for HotFolders 8-14
job overrides

(Other) Gamma option A-6
(Other) Phosphors option A-6
(Other) White Point option A-7
Black Overprint option A-3
Brightness option A-3
CMYK Simulation Method option A-4
CMYK Simulation Profile option A-4
Color Mode option A-4
Combine Separations option A-4
Duplex option A-5, A-11
Media Type option A-6, A-12
Page Order option A-7
print settings A-2
Pure Black Text Graphics option A-8
Rendering Style option A-9
RGB Source option A-9
Save Fast Reprint option A-9
Slip Sheet option A-10
Sorter Mode option A-12
Spot Color Matching option A-10
Toner Reduction option A-10

L
LaserWriter printer, fonts installed on 4-9
lp command 3-2
lpq command 3-1, 3-2, 3-3
lpr command 3-1
lprm command 3-1, 3-3
lpstat command 3-2

M
Mac OS

Paper Source menu 2-4
PostScript printer setup 2-3 to 2-6
Printer Specific Options menu 2-6
printing 2-1
screen fonts 4-9
tray selection 2-4

Match Copy
Fiery Scan option 6-23

Media Type option A-6, A-12
My Fiery List 9-4, 9-8

N
Notes fields

Windows 9x/Me/NT 4.0 1-4

O
Orientation option A-6
Original option, in Fiery Scan 6-22
(Other) Gamma option A-6
(Other) Phosphors option A-6
(Other) White Point option A-7
Output Profile option A-7
overrides, of job settings A-2

P
Page Order option A-7
Page Range option A-2
Paper Source menu

Mac OS 2-4
Paper Source option A-12
PDF files

downloading 4-1
downloading from Windows 1-1
font substitution 4-10
Hot Folder support for 8-2

performance, optimizing C-1
Phosphors option A-6
Portable Document Format, see PDF files



I-4 Index
PostScript
downloading files 4-1
font list B-1 to B-5
Hot Folder support for 8-2

PostScript printer description files, see PPDs
PostScript printer drivers

explained A-1
Mac OS 2-1
Windows 9x/Me/NT 4.0 1-1

PPDs (PostScript printer description files)
options A-2
setting print options with Mac OS 2-1

prescan 6-19
Print command (Windows) 1-1
print options

assigning to Hot Folders 8-11
Mac OS 2-3 to 2-6
saving sets of 8-11
Windows 9x/Me/NT 4.0 1-2 to 1-5

print quality, problems with C-4
printer default settings

where to set A-2
Windows 9x/Me/NT 4.0 1-5

printer setup
Mac OS 2-3 to 2-6
Windows 9x/Me/NT 4.0 1-2 to 1-5

Printer Specific Options menu 2-6
printing

duplex pages A-5, A-11
font list 4-3
Mac OS 2-1
to File port 1-21
troubleshooting C-2 to C-3
Windows 9x/Me/NT 4.0 1-1

Pure Black Text Graphics option A-8

Q
Queue Position Info tool 9-5

R
Rendering Style option A-9
RGB Separation option A-9
RGB Source option A-9
RIPping A-1
Rotate 180 option A-9

S
Save Fast Reprint option A-9
Saved Settings 1-6
Scale option A-12
scanning

canceling 6-23
from the copier glass 6-1

Shortcuts 1-10
Show menu (Mac OS) 4-6
showpage after EPS files option 4-7
Slip Sheet option A-10
SMB printing 1-2
Solaris 2.x 3-2
Sorter Mode option A-12
Spot Color Matching option A-10
Status tool 9-5
SunOS 4.1.x 3-2
Support tool 9-6

T
TCP/IP printing 3-1
TIFF/IT Converter

control panel, displaying 7-2
converting files 7-5
creating folders 7-4
preferences 7-2

Toner Reduction option A-10
Toner tool 9-5, 9-6
Top-Bottom, duplex option A-11
Top-Top, duplex option A-11
tray selection

Mac OS 2-4



I-5 Index
trays, printer A-12
troubleshooting

EPS files C-5
Fiery Downloader C-5
Fiery Scan C-6
Fiery WebTools C-6
general printing problems C-2 to C-3
print quality C-4

TrueType fonts B-6

U
UNIX

BSD (Berkeley Software Distribution) 
variant of 3-3

displaying jobs in queue 3-2
printing with 3-1
removing jobs from queue 3-3
System V 3-2

Use Master option 5-2

W
WebLink, see Fiery WebTools
White Point option A-7
Windows 9x/Me/NT 4.0

Notes fields 1-4
PostScript printer driver 1-1
printer default settings 1-5
printing with 1-1
setting print options 1-2 to 1-5
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